
      S/W concept & Terminology:- 

Introduction of Computer Software:- 

  

Computer can neither think nor take any decision itself. We instruct by means of commands or programs. 

Program:- 

It is sequence of instructions, which operate on computer data to perform certain well-defined task or 

achieve a goal. 

Software:- 

A set of programs which run on hardware and govern the functioning of computer system. 

Example of  S/W:- 

❖ MS Word. 

❖ MS Excel. 

❖ MS PowerPoint. 

❖ Notepad. 

❖ Word Pad. 

❖ Paint Brush. 

❖ Window Media Player (It is used for playing video). 

❖ VLC. (It is used for playing video). 

❖ WIN AMP. (It is used for playing music). 

❖ Coral Draw (It is used for making designing). 

❖ Photoshop. (It is used for editing images). 

❖ PageMaker. 

❖ CAD (Computer Aided Design). 

❖ CAM (Computer Aided Manufacturing). 

❖ Oracle (It is database management system). 

❖ MS Access (It is database management system). 

❖ SQL server (It is database management system). 

  Etc. 

 

Program=Algorithm+Flowchart+Language+Translator+Operating System + Data Structure.  

 

Algorithm:-Step by step, problem-solving technique is called algorithm. 

 

Example:-1 Write algorithm for addition of any two numbers 

   S=a+b 

 Step:-1  Start/Begin 

 Step:-2  Read/Input a,b 

 Step:-3  Calculate S=a+b 

 Step:-4  Print S 

 Step:-5  Stop/End 

 

Example:-2 Write algorithm for calculate simple interest of given p, n and r 

   Si=p*n*r/100 

 Where:- 

  Si  Simple Interest 

  p Principal Amount 

  r Rate of interest 

  n Period 

Step:-1  Start/Begin 

 Step:-2  Read/Input p, n, r 

 Step:-3  Calculate Si= (p*n*r)/100 

 Step:-4  Print Si 

 Step:-5  Stop/End 

 

Example:-3 Write algorithm for calculate amount with compound interest. 

  A=p*(1+r/100)n
 



  A Amount. 

  p Principal Amount. 

  r Rate of interest. 

  n Period. 

Step:-1  Start/Begin 

 Step:-2  Read/Input p, n, r 

 Step:-3  Calculate A= p*(1+r/100)n 

 Step:-4  Print A 

 Step:-5  Stop/End 

 

Example:-4 Write algorithms for checking year is leap or Not Leap. 

  

Step:-1  Start/Begin. 

 Step:-2  Read/Input year. 

 Step:-3  Calculate y=year Mod 4. // (= Assignment operator) 

 Step:-4  If y= =0.   // (= = equal operator) 

 Step:-5  Print “Leap Year”. 

 Step:-6  If y! =0.   // (! = not equal operator) 

 Step:-7  Print “Not Leap Year”. 

  Step:-8  Stop/End. 

Note:-Mod is used for calculating remainder. 

 

Example:-5 Write algorithm for generating series of natural numbers. 

Step1:-  Start/Begin. 

Step2:- Initialize a value of I=1. 

Step3:- Read Positive Integer N. 

Step4:- while I<=N //Looping statement. 

Step5:- Print I 

Step6:- I=I+1  //Increment Value of I by One. 

Step7:- Goto Step4. 

Step8:- Exit when condition Step4 is false. 

Step9:- Stop/End. 

 

Characteristics of Algorithm:- 

1.  Finiteness 

2.  Definiteness 

3.  Effectiveness 

4.  Input 

5.  Output 

 

Finiteness  :-  Steps of algorithm must be finite. 

 

Definiteness  : -  Every step must be defined. 

 

Effectiveness  : -  Each step must be effective. 

 

Input   : - Algorithm must be associated inputation. 

 

Output  :- Algorithm must be associated with output components. 

 

 

 

 

 

 

 



Flowchart:- 

  The diagrammatical/Graphical representation of any algorithm is called flow chart. 

Following Symbols are used in flowchart. 

 

 Oval    For Start/Stop 

 

 

 

  Parallelogram   For input and output 

 

 

 

  Rectangle  For process/Calculation 

 

 

 

  Diamond  For decision 

 

  

  

  Arrow   For flow direction 

 

 

  Open Ended Box For comment 

 

 

  Circle   For connector 

 

 

   S=a+b     Si=p*n*r/100 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Computer Language:- 

   Computer languages are categorized into two types 

1. LLL(Low Level Language) 

o Machine language (0 and 1). 

o Assembly Language(Symbols, codes are used instead of 0 and 1) 

2. HLL(High Level Language) 
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Si= (p*n*r)/100 
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Stop 

 

 

 



  Natural English like language. 

 Example:- 

 C, C++, JAVA, C#, COBOL, PASCAL, FORTRAN, BASIC, LISP,  

   PROLOG, Smalltalk, Python, Beta Etc. 

TRANSLATOR:- 

It is used for converting source (Program) code into object codes. (Machine 

Codes).There are following three types of translator. 

▪ Assembler(Only for assembly language). 

▪ Interpreter(Only for BASIC Language). 

▪ Compiler(All HLL except Basic). 

  

 Source Codes   Translator  Object Code (0 & 1) 

 

 

         

 

   

  

    Debug: - To remove error from source codes. 

Source Code In ‘Java’ written by programmer:- 

import java.io.*; 

class pr2 

{ 

 public static void main(String args[])   //main function of java 

 { 

     int a=5,b=6, c1,c2; 

     c1=a+b; 

     c2=a*b; 

     System.out.println ("Sum="+c1+"\n"+"Product ="+c2); //For display on screen 

    } 

}  

 

Source Code In ‘C’ Written by Programmer:- 

#include<stdio.h>     //main function of C 

  main() 

  { 

  printf("Welcome in C Programming Language"); //For display on screen 

  } 

Where:-  

 #   Preprocessor directive, which attach c library to header file  

 stdio.h  Standard input/output header file  

Advantage of HLL:- 

o Easy To understand. 

o Fast S/w Development. 

o Fast debugging (To remove error). 

o Natural English like language. 

o Better portability. 

Difference between Interpreter and compiler:- 

Interpreter(System S/w) Compiler(System S/w) 

1:- Convert source code into object code line by line. 1:-Convert entire source code into object code at a time. 

2:- Debugging is very fast. 2:-Debugging is slow. 

3:- More Execution time. 3:-Less execution Time. 

4:- Used only in QBASIC/BASIC. 4:-Used in all HLL. Except QBASIC/BASIC. 

 

 

 

No any error (bug) in source code 



Types of Software:- 

o Application S/W(MS WORD, MS EXCEL,MS Power POINT, Coral Draw, Photoshop etc). 

o System S/W. (Translator, Operating System, Loader, Linker). 

o Utilities S/W (Driver of Motherboard, Monitor, Modem, Sound card etc). 

Operating System :-(OS) 

   It is collection of s/w which is used for managing computer resources such as  

❖ Memory System. 

❖ File System. 

❖ I/O System. 

❖ CPU/Processor. 

❖ Protection. 

❖ Networking management. 

❖ Command Interpretation. 

❖ Process Management. 

 OS provides a platform for any application s/w.That is, It is soul of computer. 

 without OS, user never interact with computer hardware to do some work. 

 

Example:- Category Based OS. 

      CUI (Command/Console User Interface) Based OS:- 

❖ MS DOS ( Microsoft Disk Operating system).→Single user. 

❖ LINUX→Multiuser. 

❖ UNIX→Multiuser. 

GUI (Graphical User Interface) Based OS:- 

❖ MS Windows 95. 

❖ MS Windows 98. 

❖ MS Windows 98 SE (Second Edition). 

❖ MS Windows ME (Millenium). 

❖ MS Windows NT (New Technology). 

❖ MS Windows 2000 Professional. 

❖ MS Windows Advanced Server. 

❖ MS Windows XP. 

❖ MS Windows VISTA. 

❖ MS Windows 2007. 

❖  MS Windows 2008 

❖ MS Windows 2010 etc. 

 

Organization of Computer system with OS 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

User1 User2 User3 User4 User5 User6… 

Application S/w 

System S/w 

       OS 

H/W 



 

 

There are two ways by which user interface with OS. 

❖ By System Call 

❖ By Commands 

System call:-It provides interface with running program and OS. 

Command:- It is another way by which user interact with OS. 

 MS DOS Commands 

  1:-Internal Commands (Already Available in system). 

   Date→(It is used for display system date). 

   Time→ (It is used for display time). 

   CLS→ (It is used for clear screen). 

   VER→ (It is used for display version of MS Dos). 

   REN→ (It is used for Renaming files and folders). 

   Dir→ (It is used for display list of files and folders). 

   Type→ (It is used for display contents of file). 

   Copy→ (It is used for copy file from one location to another location). 

   MD→ (It is used for making directory/Folder). 

   CD → (It is used for entering existing directory/Folder). 

   RD → (It is used for removing directory/Folder). 

   DEL→ (It is used for removing file/files). 

   Etc. 

 2-External Commands (We Load by means CD/DVD/PEN Drive) 

   XCOPY→ (It is used for copying files and folders both) 

   SCANDISK→ (It is used for checking disk It also repair of disk) 

   MEM→ (It is used for displaying memory information) 

   CHKDSK→ (It is used for checking disk) 

   ATTRIB→ (It is used for setting attributes such as hidden files, read only file etc) 

   DEFRAG→ (It is used for converting unused space into usable space) 

   FORMAT→ (It is used for new tracks and sectors in disk) 

   SYS→ (It is used for making bootable disk) 

   BACKUP→ (it is used for making additional files of existing files for future loss of files) 

   RESTORE→ (It is used for restoring files again in system) 

   DOSKEY(It is used for loading MS dos commands and make history of Dos Commands.) 

   PROMPT→ (It is used for changing prompt of system) 

   Etc. 

   C:\> or D:\>,E :\> etc \ Root Directory,>Prompt. 

  UNIX/LINUX commands:- 

   cp (It is used for copying file/files). 

   md (It is used for making directory/Folder). 

   rd (It is used for removing directory/Folder). 

   cal (It is used for displaying calendar).  

   man (It is used for display help about any command). 

   chmod (It is used for setting attributes on file and directory). 

   passwd (It is used for changing password). 

   kill (It is used for killing running process). 

   grep (It is used for searching). 

   wall (It is used for sending message from super user on each terminal). 

   news(It is used for display news to every user, related sports, political etc). 

   mail (it is used for sending message to any terminal). 

   pwd (It display current working directory). 

   who (It display all connected users). 

   cat (It is used for displaying content of existing file) 

   touch (It is used for creating empty file) 

   head (It is used for display list of files from bottom to top) 

   tail (It is used for display list of files from top to bottom) 



   echo (It is used for displaying message on screen) 

   who am i (It is used for displaying information its own terminal) 

   ls (It is used for display list of files and folders) 

   etc. 

Evolution of OS:- 

There are three categories of evolution of OS. 

❖ Serial Processing 

o In serial processing instructions are executed in sequential manner over data. 

Example:- Source code→Translator→Object Code→Loader load in to memory→Linker Link 

With library files→Execution. 

❖ Batch Processing 

o Instructions are executed in batch form.Utilization of CPU become more efficient than serial 

processing. There are two techniques are used in batch processing. 

▪ Buffering Technique:- 

 It is method of overlapping input, output and processing of a single job.It produce 

better performance of CPU. 

▪ Spooling Technique:-( Simultaneous Peripheral Operation On Line) 

  It is more sophisticated form of input/output buffering is called spooling. 

   Hard disk 

 

  

 Input  CPU  Printer 

❖ Multiprogramming 

In concurrent situation utilization of CPU, become more efficient than buffering and spooling 

technique. Idle (Rest time of CPU) time become minimize. 

 

Example:- 

Threads of Program1 are:- P1  P1 P1 P1 P1 

Threads of Program2 are:- P2 P2 P2 P2 P2 P2 

  

In sequential manner 

 

 

             

 

 

 

 

      Idle time 

 

In Multiprogramming approach 

 

 

 

 

 

Types of OS:- 

o Batch OS. 

o Time sharing OS. 

o Real Time Operating System. 

o Multiprogramming OS. 

o Multiprocessing OS. 

o Network OS. 

o Distributed OS. 

o OS for Embedded Devices. 

P1 P1 P1 P1 P1 P2 P2 P2 P2 P2 P2 

Time t 

P1 P1 P1 P1 P1 P2 P2 P2 P2 P2 P2 P2 

t1<t 



 

Batch OS:- 

 In batch OS utilization of computer resources and improvement in programmer’s productivity. 

 In this OS users submit jobs to a central place where these jobs are collected into a batch & subsequently 

 placed on an input queue at computer where they will be run. The user has no interaction with the job 

 during its processing. 

Example:-1:- 

 Step1:-  $COB  → Execute the COBOL compiler. 

 Step2:-  $JOB  → Read Source Code 

 Step3:-  $End  → End of Job 

Step4:-  $LOAD →  Load program into memory 

Step5:-  $RUN  →  Execute the user program 

When job is submitted, user can not debug in runninge mode.There are two way for debugging 

❖ Off line debugging. 

❖ Non interactivity 

Example:-2:-Payroll System (It is used for making salary sleep of any organization). 

Time Shairing OS:- 

 In this environment a computer provides computing service to several or many users concurrently  

 On-Line. 

Real Time OS:- 

 Such type of OS is used to control Machinary, Scientific instruments and industrial Systems. 

 Example:- Real Time Training System of Software company. 

   Video Conferencing System,Satelite Launching etc.       

Multiprogramming OS:- 

It is multiuser, multitasking, time shairing and real time system.In this OS, multiprogramming processing 

approaches are implemented. It allows more than one active user program to be stored in main memory 

simultaneously. 

Multiprocessing OS:- 

In this OS a computer H/W configuration that includes more than one independent processing. It is 

generally used in major scientific or commercial applications. 

Network OS:- 

 A network OS is a collection of S/W and associated protocols that allows a set of autonomous computes 

 which are interconnected by computer network to be used together in a convenient and cost effective 

 manner. 

Note:-Set of formalized access rules is called protocols.  

Characteristics of Network OS:- 

❖ Each computer has its own Network OS. 

❖ Each user normally works on his/her own system. 

❖ Users are typically aware of where each of their files are kept and must move file from one system to 

another. 

 

 

 

  

 

 

 

 

 

 

 

 

Capabilities of Networks OS:- 

 

❖ Allow user to access the various resources of the network hosts. 

❖ Controlling access. 

Network OS 

(Server) 

C5 

C6 

C2 

C3 

C4 

C1 



 

Distributed OS:- 

It is a network of autonomous computers connected by communication networks.It controls and manages the 

H/W and S/w resources of distributed system.Key feature of Distributed OS is transparency. 

Example:-CBS of Banking, Air traffic Control System, Reservation System of Airlines and Railway. 

Advantages:- 

❖ Resource Shairing. 

❖ Reliability (failure free operations may perform). 

❖ Communication among various categories of organizational network. 

❖ Incremental Growth (Very fast work). 

❖ Major break through in microcomputer. 

 

Application Driven OS:- 

❖ Multimedia OS:- 

It provides a comfortable environment for the execution programs, and it ensures effective 

utilization of computer H/W.It uses processing of audio and video, multimedia application.  

❖ Database OS:- 

It supports database system, that perform transaction, operations to store, retrieve and manipulate a 

large volume of data efficiently. It control concurrency and system failure recovery. 

❖ Real Time OS:- 

The main characteristics of the real time system is the correctness of the computation.The main  

issues of real time system is the scheduling of jobs in such a way that a maximum number of job 

satisfy their deadlines. 

Example of Operating Systems:- 

 1:-MS DOS 

  It is single user operating system.We can not established a network by using MS DOS. 

  It is command based OS. 

 2:-UNIX 

  It is multiuser, multitasking network based OS. It is also command based OS.It is the product of  

  SUN microsystem.This OS developed in ‘C’ language at AT & T laboratory.There are following  

  three types of unix shell.(Say korn shell, born shell,c shell). 

 3:-Windows 

It is GUI based operating system. It work on the principle of WYSIWYG(What You See Is What   

You Get).Windows is the product of Microsoft.  

 4:-Macintosh 

It is also GUI based operating system. It work on the principle of WYSIWYG(What You See Is 

What You Get). Macintosh Windows is the product of Apple Computer.  

Layered Structure of OS:-( Full Question but explain all in brief) 

 Layerd-0 Hardware. 

 Layerd-1 CPU scheduling (To Improve performance of CPU). 

 Layerd-2 Memory Manager (To manage Memory by OS). 

 Layerd-3 Device driver (Example PCB Driver,DVD Driver,Printer Driver,VGA Driver). 

 Layerd-4 Buffering for I/O Devices (To provide temporary space for I/O devices). 

 Layerd-5 User programs. 

Virtual machine:- 
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It manages with virtual machine OS 

Note:- 

 Time Sharing System:- 

  This system allows many users simultaneously share the computer resources. 

 Real Time System:- 

A large number of events mostly external to computer systems, must be accepted  and processed in  

short time or within certain deadline 

  Example:-Flight Control, Video Conferencing. 

Processes:- Most Important→ Full Question 

  A running state of program in CPU is called process or task. 

    Or 

A process is an instance of a program running in a computer. It is close in meaning to task, a term used in 

some operating systems. In UNIX and some other operating systems, a process is started when a program 

is initiated (either by a user entering a shell command or by another program).   

Types of Tasks in Process:- 

• Implicit task(It is defined by System) 

• Explicit Task(It is defined by User) 

A process or task is an instance of a program in execution. 

A number of informations are needed to complete successful operation. These are associated in PCB 

(Process Control Block).Following information in PCB. 

• Process name. 

• Priority. 

• Process State (Ready→Running (CPU) →Termination or suspended). 

• Hardware State. 

• Scheduling (To improve performance of CPU). 

• Memory Management information.  

• I/O status. 

• File management Informations. 

• Accounting information.  

 

Process –State Transition Diagram:- 

 There are following four categories for process states. 

1:- Dormant State (Creation of jobs/threads/Processing Elements). 

2:- Ready State (Processing elements are ready to acquire all resources except CPU). 

3:- Running State (Execution of jobs in CPU). 

4:- Suspended (Due to lack of resources). 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scheduler: 

It is a module to select next job for execution in CPU.There are following three types of scheduler. 

• Long Term Scheduler 

• Short Term Scheduler 

• Medium Term Scheduler 

 Role of scheduler is to schedule job for CPU.That is, To improve performance of CPU.It is 

 called scheduling technique.Scheduling refer to a set of policies and mechanisms built into 

 the OS that govern the order in which the work to be done by a computer system is 

 completed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The long term Scheduler:- 

 Long term scheduler provides complete resource except CPU & enter ready queue.  

 To complete successful termination from CPU resource. 

The Short term Scheduler:- 

 This scheduler allocate CPU resource from ready queue job. 

The Medium term Scheduler:- 

 When job suspended from CPU,It again enter ready queue & prepare for processing. 
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Scheduling & Performance Criteria:-Scheduling refer to a set of policies and mechanisms built 

into the OS that govern the order in which the work to be done by a computer system is completed. 

There are following attribute to maximize performance of system 

• CPU utilization→A technique for Maximum utilization of CPU. 

• Throughput→  Maximum output provided by CPU per cycle. 

• Turnaround Time→Quickely termination of job from CPU resource. 

• Waiting Time→Minimum waiting time should be previous job. 

• Response Time→There must be quick response time. 
Scheduling Algorithm:- 

• FCFS (First Come first Serve) scheduling Algorithm. 

• SJF/SRTN (Shortest Remaining Time Next) Scheduling Algorithm. 

• RR ( Round Robin)Scheduling Algorithm. 

• ED/Priority Based(Event Driven) Algorithm. 

 

FCFS (First Come first Serve) scheduling:- 

 

Program→ 

 

CPU Time/Burst Time     3         2      7        1       4 

 

WT of P1=0 

WT of P2=4 

WT of P3=5 

WT of P4=12 

WT of P5=14 

Average WT=(0+4+5+12+14)/5=7 Unit Time 

TAT of P1=4 

TAT of P2=5 

TAT of P3=12 

TAT of P4=14 

TAT of P5=17 

Average TAT=(4+5+12+14+17)/5=6.5Unit Time 

 

SJF/SRTN (Shortest Remaining Time Next) Scheduling Algorithm:- 

 

Program→ 

 

CPU Time/Burst Time      5         3      6        2       1 

 

   P3→P5→P4→P2→P1 

   6 5     3       2     1 

WT of P1=0 

WT of P2=1 

WT of P3=11 

WT of P4=3 

WT of P5=6 

Average WT=(0+1+11+3+6)/5=4.2 Unit Time 

TAT of P1=1 

TAT of P2=3 

TAT of P3=17 

TAT of P4=6 

TAT of P5=11 

Average TAT=(1+3+17+6+11)/5=7.6 Unit Time 
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RR (Round Robin) Scheduling Algorithm 

 In this algorithm CPU time, splits into discrete time interval.After then perform processing 

according queue of RR. 

 

 

CPU Time/Burst Time      5         3      6        2       1 

CPU slice Time=1 Unit 

 

 

WT of P1=0 

WT of P2=1 

WT of P3=2 

WT of P4=3 

WT of P5=4 

Average WT=(0+1+2+3+4)/5=2 Unit Time 

TAT of P1=1 

TAT of P2=6 

TAT of P3=17 

TAT of P4=11 

TAT of P5=16 

Average TAT=(1+6+17+11+16)/5=10.2 Unit Time 

 

Priority (Event Driven ) Scheduling Algorithm:-  

 

 

 

CPU Time/Burst Time      5         2      6        3       1 

Priority Order          5         3      4        2       1 

 

 

 

 

CPU Time/Burst Time      5         6      2        3       1 

 

WT of P1=0 

WT of P2=1 

WT of P3=6 

WT of P4=4 

WT of P5=12 

Average WT=(0+1+6+4+12)/5=4.6 Unit Time. 

 

TAT of P1=1 

TAT of P2=4 

TAT of P3=12 

TAT of P4=6 

TAT of P5=17 

Average TAT=(1+4+12+6+17)/5=8 Unit Time. 

 

Interprocess Synchronization among Concurrent process:- 

  Explicit interprocess must interact by using following three forms. 

• Interprocess Synchronization. 

• Interprocess Signaling. 

• Interprocess Communication. 
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Interprocess Synchronization:- 

A set of protocols and mechanisms used to preserve system integrity and consistency when concurrent 

processes share resource that are serially reusable.A serially reusable resource can be used by at most one 

process at a time. 

Interprocess Signaling:- 

The exchange of time signals among concurrent processes or threads, used to coordinate their collective 

progress. 

Interprocess Communication:- 

The concurrent cooperating process must communicate for such purposes as exchanging data, reporting 

progress accumulating collective result. 

The need for interprocess Synchronization:- 

Synchronization facilitates common form of communication among cooperating processes.When a set of 

processes have access to a common address space.They can use shared variables for number of purposes 

Such signaling flags and communicating collective result. 

Note:-Signaling flags:- 

  It provides status informations. 

 

Concurrency Control Algorithm:- Most Important 

• Mutual Exclusion. 

• Semaphores. 

• Queuing Implementaion of semaphores. 

• Disable/Enable Interrupts. 

• Test and Set Instruction. 

• Producer and Consumers Problem. 

• Readers and Writers. 

• Dekkers Algorithm. 

• Bakery’s Algorithm. 

• Dining Philosophers Problem. 

• Sleeping Barber Problem. 

 

Critical Region:-It is a temporary buffer which is used for allocation resource for processing elements/Threads. 

 Shared resource variable may exist in critical section/Region. 

Mutual Exclusion:- 

 It ensures that at most one process at a time has access to it during the critical updates that leads to 

temporarily inconsistent values. Operations performed in a mutually exclusive way.Only one program at any 

point is allowed to control serially reusable device. 

Common Problem In Mutual Exclusion:- 

• It ensures accessing the protected shared resource. Until the processes have to be completed. 

• Make to assumptions about relative speeds priorities of contending processes. 

• Gaurantee that crashing or terminating of any process outside of its critical section.   

 

 

 

Semaphores methods/Algorithm:- 

 There are two primpitive operations are used in this algorithm. 

• Wait. 

• Signals. 

Both types of primitive operations are performed on a special type of variable,whch is called semaphores.It is 

denoted by (s). 

Wait(s): While not(s>0) do {keep testing}; 

   s:=s-1; 

Signal(s): s:=s+1; 

 

 

 



Queuing Implementation of semaphores 

   

 

 

 

Wait(s): if not(s>0) then suspended the caller at s 

   Else s:=s-1; 

Signal(s): if queue is not empty then resume a process from queue at s 

Else s:=s+1; 

Disable/Enable Interrupts 

The processor services interrupts and exceptions only between the end of one instruction and 

the beginning of the next. When the repeat prefix is used to repeat a string instruction, 

interrupts and exceptions may occur between repetitions. Thus, operations on long strings do 

not delay interrupt response. 
 DI   Disable interrupts 

<Critical_section> Use guarded resource 

EI   Enable interrupts 

It is used in mostly all types commercial computers.Use of these instructions shared resources used by 

jobs effectively manner. 

 

Test and Set Instruction (TS):- 

 TS method control concurrency as semaphore.It act as following 

Busy Operation:- 

TS operand→ First test and set 

1:- Operand, First test and then set. Compare the value of the operand to BUSY, and set the  

      condition codes to reflect the outcome.  

2:- Set the operand to busy. 

Wait Operation:- 

Assume that several processes are executing WAIT in an attempt to access the resource protected 

by global variable S. 

  WAIT : TS S→Request exclusive access. 

BNF(Branch if not free) →WAIT 

RETURN →Proceed to critical section. 
This algorithm uses busy waiting and works for only two processes. 

Producer & Consumers Problems:- 

 It is stated as given a set of cooperating processes, some of which “produce” data items (Producers) to be 

 “Consumed” by others (Consumers), with possible disparity between production and consumption rates.It 

 uses following two types buffers. 

• Bounded Buffer (Producers may run as predefined allotted time between producers and consumers 

disparity). 

• Unbounded Buffer (Producers may run at any time). 

Or 

Producer consumer problem is a classic example of multi process synchronization problem. It have two 

types of runnable processes.Producer - which produces a piece of data and puts it in a queue. Consumer - 

which consumes a piece of data from a queue 

Readers and Writers:- 

It is classical method of controlling concurrency. The processes are categorized depending on their usage 

of the resource as either readers or writers. 

In a readers never modifies the shared data structure. 

In a writers both read it and write into it. 

A number of readers may use the shared data structures concurrently. 

Where as writers must be granted exclusive access to data.  
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Dekker’s Algorithm:- 

  



Interprocess Communication and Synchronization:- 

 

Concept of critical region and conditional critical region:- 

Critical Region:- 

  A critical region protects a shared data structure by making it known to compiler, which 

can then generate code that maintains mutually exclusive access to the related data. 

The declaration of a shared variable has the following format. 

var mutex: shared T;  

Where the keyword shared informs the compiler that the variable mutex,of user defined-variable type T,is 

shared by several processes. 

Process may access a guarded variable by means of the region construct as follows. 

  region mutex do; 

 Conditional critical region:-  

It is syntactically similar to a critical region.The shared variable is declared in the same way. But  

critical region declared by different way. 

var mutex:shared T; 

begin 

… 

Region v do 

… 

await <condition>; 

… 

end; 

Implementaion of this construct allows a process waiting on a condition within a critical region to be 

suspended in a special queue, Pending satisfaction of the related condition.  

 

Monitors:- 

It is an OS structuring mechanism that address this issue in a rigourous and systematic manner. 

The basic idea behind monitors is to provide structural data abstraction in addition to concurrency 

control. 

Declaration format of Monitor:- 

 

<Monitor_name>:monitor; 

Begin 

Declaration of private data; 

… 

… 

Procedure <procedure_name> 

Begin 

Procedure_body; 

End; 

… 

Procedure <private_name> 

… 

Initialization of monitor data; 

… 

End <monitor_name>; 

A collection of monitor procedures may thus handle buffer management 

And synchronization of concurrent request internally. 

 

Messages:- 

It is relatively simple mechanism suitable for both interprocess communication and 

synchronization in centralized as well as in distributed environment. A message is characterized by its 

type, length, sender and receiver IDs and data field. 

 

 



Message Format:- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Issues in Message Implementation:- 

 Typical message operations provided by the operating system or predeclared in a system 

implementation language are send message and receive message. Following issues are used in message 

implementation:- 

• Naming 

• Copying 

• Synchronous Vs asynchronous 

• Length 

Naming:- 

 It is used message as following format 

 

Process A; 

… 

Send (B, Message); 

… 

Process B; 

… 

Receive (A, Message); 

… 

  Direct Naming Techniquee 

It act as 1:1 mapping. Naming should be either Direct or Indirect. 

 

 Process A; 

… 

Send (mailbox1, Message); 

… 

Process B; 

… 

Receive (mailbox1, Message); 

In Direct Naming Techniquee 

Message to Process B via Mailbox1. 

Copying:- 

Message exchange between two processes, By definition transfers the contents of the message from the 

sender’s to the receivers addressing space. By using technique of copying. 

Synchronous Vs Asynchronous:- 

When a message exchange is synchronous, both sender and receiver must come together to complete the 

transfer. 

In asynchronous system, the send operating is blocking. 

This technique relatively low overhead and ease of implementation, as well as the fact that the sender 

knows that its message has actually been received once the sender is past the send statement. 

 

Sender Message 

Receiver ID 

Length 

Type 

… 

… 

… 

… 

Message Header 

Message Body 

(Optional) 



Disadvantage:- 

• Forceful operation of sender and receiver. 

• In asynchronous Sender is not blocked. 

Format of receive:- 

 Receive (mailbox, message, time_limit); 

Format of send:- 

 Send (mailbox, message); 

Length:- 

 It is final issues of implementation that should be fixed or variable length. It determine buffer space for 

processing elements to maintain interposes communication synchronization. Its total value for per message 

become size of message and size of process elements (threads). 

Buffer space=(size of message+Size of Threads)*Number  of processing elements 

Deadlocks:-Most Important 

 It is a situation where a group of processes are permanently blocked as a result of each process having 

acquired a subset of resources needed for its completion and waiting for release the remaining resources held by 

others in the same groups.-Thus making it impossible for any of the processes to proceed. It occurs only in 

concurrent uncontrolled environment. 

 

      Or 

A set of processes is in a deadlock state if each process in the set is waiting for an event that can be caused by 

only another process in the set.In other word,each member of the set of deadlock processes is waiting for a 

resource that can released only by a deadlock process. 

 

The described conditions actually illustrate the necessary conditions for deadlock which may be stated more 

explicitly as follows. 

• Mutual Exclusion:- 

The shared resources are acquired and used in a mutually exclusive manner, that is, by at most one 

process at time. 

• Hold & Wait:- 

Each process continues to hold resources already allocated to it while waiting to acquire other 

resources. 

• No preemption:- 

Resources granted to process can be released back to system only as a result of the voluntary 

action of that process,As the system cannot forcefully revoke them. 

• Circular waiting:- 

Deadlocked processes are invoked in a circular chain such that each process holds one or more 

resources being requested by the next process in the chain. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The simultaneous existence of these conditions defines the state of the deadlock. 

In other words, all four conditions must be present for a deadlock to occur. 
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Deadlock Prevention:- 

1:-Hold & wait condition can be eliminated by requiring or forcing a process to release all 

resources held by it whenever it requests a resource that is not available. In Other words, 

deadlocks are prevented because waiting processes are not holding any resources. 

 

2:- The no prevention deadlock conditions obviously be denied by allowing preemption. 

 

3:-Deadlocks are prevented by requiring all process to request and acquire their resources 

in a strictly increasing order of the specified system resource classes. 

 

Deadlock Avoidance:- 

The basic idea of deadlock avoidance is to grant only those requests for available resources 

that can not possible result in a state of deadlock. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    Deadlock avoidance Graph 

Before Allocation of resources:- 

 

R1 R2  R1 R2  R1 R2   

P1 1 0 P1 1 2  0 2 

 

P2 0 1 P2 0 1 

 

Allocated  Claims    Available 

 

After Allocation of resources:- 

 

R1 R2  R1 R2  R1 R2   

P1 1 0 P1 0 2  0 1 

 

P2 0 1 P2 0 0 

 

Allocated  Claims    Available 

 

 

 

 

 

P1 

R1 

     R2 

P2 



Deadlock Detection and Recovery 

 This approaches, the resource allocator simply grants each requests for an available resource.When  

 called upon to determine whether a given system state is a deadlock. Following algorithm steps are  

 including. 

 

Step1:-Form ALLOCATED, REQUESTED and AVAILABLE in accordance with the system state.Unmark all  

active process 

Step2:-Find an unmarked process i such that 

 REQUESTEDi<=AVAILABLE 

 If found, mark process i,update AVAILABLE 

 AVAILABLE: = AVAILABLE + ALLOCATED  

And repeat this step.When no qualifying process can be found, proceed to next step. 

Step3:- If all processes are marked, The system is not deadlocked.Otherwise, the system is deadlocked. 

 And set of all unmarked processes is deadlocked. 

   P1 

 

 

 

 

 

R1          R2 

 

 

 

 

 

 

 

 P2 

    System State 

 R1 R2  R1 R2  R1 R2 

P1 1 1 P1 0 1  0 0 

 

P2 0 1 P2 1 0 

 

Deadlock detection:- 

 It is only a part the deadlock handling task. 

 

Deadlock Recovery:- 

 It can be attractive in systems with low probability of deadlocks. 

 

Memory Management (Primary Memory):-Most Important for 25 marks 

Allocation of job in memory may be performed by two technique. 

 1:- Contiguous Allocation 

 2:- Non Contiguous Allocation 

We will discuss in this topic of principles of managing the main memory (RAM).It is one of precious resources in 

a multiprogramming system. 

It is primarily concerned with allocation of physical memory of the finite capacity to requesting processes. No 

process can be activated before a certain amount of memory can be allocated to it.  

Memory management is the role of memory manager in a multiprogramming environment. It support both 

memory protection and sharing of memory.The function of memory management depend upon partitioning. 

Types of partitioning:- 

There are two types of partitioning Technique. 

• Static Partitioning. 

• Dynamic Partitioning (Variable Partitioning). 
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Static Partitioning:- 

 Such types of partitioning technique, Number of partitions are fixed.Loss of memory in static partitioning 

 is called internal fragmentation (Loss of Memory). 
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Contiguous Allocation of Jobs/Threads/Processing Elements:- 

 

 

 

 P4 P3 P2 P1 

 

 

 

 

 

 

Note :- Loss of memory is called fragmentation. 

   To convert fragmented memory in usable form is called defragmentation. 

 

Non Contiguous Allocation of Jobs/Threads/Processing Elements:- 
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Fragmentation Analysis In Memory:- 

 To provide a common basis for comparison, we analyze each scheme informally with respect to following 

measures. 

• Wasted memory 

• Time complexity 

• Memory access overhead 

Wasted memory:- 

 It is considered to be the fraction of unused physical memory that a given memory management 

scheme is unable to allocate when processing sequence of memory request. By unused memory not 

allocated to the system or user object. 
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Time complexity 

It refers to the computation complexity of allocating and deallocating memory on prerequest basis of a 

particular memory management algorithm. 

Memory access overhead 

It refers to the duration of the additional operations performed by a given memory management scheme in 

accessing memory. 

Memory Allocation Technique:- 

• First fit (Allocation according to queue one by one) 

• Best Fit (Searching time taken by selecting suitable space) 

• Worst Fit(Only Theoretically Possible) 

Principles of Operation (In static Partitioning):- 

1:- The number of partitions are fixed. Information about partitions are strored into PDT( Partition 

Description Table).Partition allocation strategy  fulfill by first fit technique.PDT consist of partition 

number,Partition base,Partition Size and partition status. 

Partition No. Partition Base Partition Size Partition Status 

0 0k 100 K allocated 

1 300k 450K Free 

2 400k 200K allocated 

3 600k 300K Free 

4 750k 80K allocated 

5 900k 100K allocated 

6 1000k 90K allocated 

 

Constraints/Validation Rule:- 

• No partition is large to accommodate the incoming process. 

• All Partitions are allocated 

• Some partitions are free, but none of them is large enough to accommodates the incoming process. 

2:- Swapping:- 

 Swapper is an OS process whose major responsibilities include 

• Selection of process to swap out. 

• Selection of process to swap in. 

• Allocation and management of swap space. 

There are two basic options regarding placement of a swap file. 

• System-wide swap file. 

• Dedicated, per process, swap file.  

3:- Relocation:- 

 It refers to the ability to load and execute a given program into an arbitrary place in memory. 

 There are two type of relocations. 

• Static relocation 

• Dynamic relocation 

 

Static relocation:- 

It implies that relocations is performed before or during the loading of the program into memory, 

by relocating linker or a relocating loader respectively. 

 Dynamic Relocation:- 

In this technique relocation implies that mapping from the virtual address space to the physical 

address at run time. 

 

 

 

 

 

 

 

 



 

 

Addressing Technique/Mapping:- 
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Virtual     Relocation 

Address                                      Primary Memory/Main Memory 

 

 Physical Address 

 

4:-Protection:- 

The integrity of multiprogramming system depends, among other things on the system’s ability to enforce 

is isolation of separate address space. 

5:-Shairing:- 

Memory management mechanism must also provide for controlled sharing of data & code between 

cooperating processes. Following three approaches to sharing in systems with fixed partitioning of 

memory.  

• Maintain multiple copies. 

• Use shared memory partitions. 

• Entrust shared object. 

 

Memory Management Technique:- 

  There are following three techniques are used for memory management:- 

• Paging Memory management 

• Segmentation Memory management 

• Virtual Memory Management 

 

Paging memory Management Technique:- 

  

Concept of Page and page Frames:- (Pages are logical & page Frames are Physical):- 

Physical memory is conceptually divided into a number of fixed-size blocks called frames 

(or page frames).The virtual address space or logical memory of a process is also broken into blocks of the 

same size called pages.(Page size equivalent to 256 or 28). 

     Or 

  A page is a unit of logical memory of a program. A frame is a unit of physical memory. All pages are of 

the same size. All frames are of the same size. 

   Allocation of pages into page frame is called paging technique. The information of pages 

 are stored into Page Map table(PMT).The size of page is typically a power of 2 that makes a translation of 

 a virtual address into a page number & a page offset. 
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Paging system diagram is shown in following figures.  
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Sharing & Protection in paging System:- 

Sharing:- 
In multiprogramming environment, where several users want to execute the same s/w, keeping a separate 

copy of the same for individuals users will cause wastage of much of primary memory. In Such situation, 

Memory management mechanism must also provide for controlled sharing of data & code between 

cooperating processes. Following three approaches to sharing in systems with fixed partitioning of 

memory.  

• Maintain multiple copies. 

• Use shared memory partitions. 

• Entrust shared object. 

Note:-careful resource allocation among concurrent process is called cooperating processes. 

Protection:- 
The integrity of multiprogramming system depends, among other things on the system’s ability to enforce 

is isolation of separate address space. 

 

Segmentation memory management technique:- 
It is another type of memory management technique which supports programmer’s view of 

memory. Programmers think of their programs as a collection of logically related entities, such as:- 

• Functions. 

• Global or Local data areas. 

• Arrays. 

• Stack. 

• Queue. 

• Procedures. 

• Linked List etc 

Or 

Memory-management scheme that supports user view of memory. 
A program is a collection of segments. A segment is a logical unit such as: 
main program  

procedure 



function 

method    
object        
local variables 

global variables 

common block 

stack        
symbol table 

arrays 

  

User’s View of a Program 
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Addressing Mapping in Segmented System 

 

 
 

Information about logical addresses is stored into segment map table. 

Addressing Mapping in Segmented System:- 

 

                    Virtual address(Segment No offset)       Segment table 

 

 

 

 

 

 Virtual  

 Address 

 

       

              Base Address Size  

 

 500 

 

 No 

 

 Yes 

 

Physical Address (1500+500) 

 

Virtual memory management technique:-When large programs not fit into small memory. The solution 

developed was break into small pieces called overlays. It denoted as:-Overlays 0, Overlays 1, Overlays 2, 

Overlays 3… The Overlays used to be on hard disk & swapped out in & out of memory by OS. 

Overlays Laying of code data on the same logical addresses - this is the reuse of logical memory. Useful when the 

program is in phases or when logical address space is small. 

Advantages of Virtual Memory:- 

• A process may be loaded into a space of arbitrary size. 

• User utilizes less memory. 

• User would be able to write very large program. 

Virtual memory management Policies:- 

 Policies of virtual memory management are classified into four types. 

• Allocation Policies:- 

o How much real memory to allocate each active process. 
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• Fetch /Load Policy:- 

o Which page to bring from secondary memory 

• Replacement(Swap-Out):- 

o If there is no space for a new page in physical memory, which page is to be selected for swapping 

out secondary memory in order to mark room for new page. 

• Placement Policy:- 

o Where to place an incoming new page into physical memory. 

 

STEPS IN HANDLING A PAGE FAULT:-  Important 

If the program tries to access a page that was not swapped out in memory, In this case, page fault trap 

occurs. For this reason OS failure to bring valid part of program.Handeling event shown in following 

diagram. Event performs following six steps. 

1. If a process refers to a page which is not in physical memory. Then PCB verifies the referenced 

page is valid or not valid. 

2. If the memory reference to a valid page but page is missing. 

3. Free memory location is identified to bring a missing page. 

4. By reading a disk, the desired page is brought back into the free memory location. 

5. Once the page  is in physical memory, the internal table kept with the process & PMT updated 

6. Restart the instruction that was interrupted due to the missing page. 

Or 

STEPS IN HANDLING A PAGE FAULT:- 

 1. The process has touched a page not currently in memory. 

 2. Check an internal table for the target process to determine if the reference was valid (do this in                     

 hardware.) 

 3. If page valid, but page not resident, try to get it from secondary storage.  

4. Find a free frame; a page of physical memory not currently in use. (May need to free up a page.)  

5. Schedule a disk operation to read the desired page into the newly allocated frame. 

 6. When memory is filled, modify the page table to show the page is now resident. 

 7. Restart the instruction that failed 
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         Physical memory 

Thrashing:- 
When a system spends more time processing in page faults than executing transactions. 

 Such events are known as thrashing. It reduces performance of system activity. 
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File management(Secondary memory):- Important 20 Marks 

 File:-It is collection of related information defined by its user. It is the heart of application S/W. 

 file contains anything such as 

• Resume/Biodata. 

• Report. 

• Executable S/w. 

• Set of library functions. 

• Image file. 

• Video file. 

• Audio file. 

• Graphics file etc. 

 

File is most visible part of any OS.It is heart of application s/w.File should kept in protection format 

because of unauthorized person can not access. 

 

File management:- 

Files must be kept in system in proper manner by using hard disk, PD, CD ROM, Memory chips, 

Magnetic tape etc. 

File management Organization:- 

There are following three categories of file organizations 

• Byte sequence. 

• Sequence of fixed size records/Record sequence. 

• Free disk blocks. 

Byte Sequence:- 

This technique of file organization used in UNIX OS.UNIX OS considers each file to be a sequence of 8 bits 

(Byte).OS direct execute the file there is no need of interpretation. 

 

 

  

  8 bits=one Byte 

  1 bit reside one cell 

 

   

    One Byte reside One Block 

 

Sequence of fixed size records/Record Sequence:- 

 

 Arbitrary records can be read or written,but records can not be inserted or deleted in the middle of a file. 

 CP/M operating system use this type of file scheme. 

 

Free Disk Blocks:- 

 In this file organization scheme, each block holding n key records. Every records can be searched by key 

value & new records can be inserted anywhere in the file structure.Such technique basically used in mainframe 

computer where accessing performed by index sequential Access Method (ISAM).Storage capacity of each block 

is 512 bytes. 

 

Responsibilities of file management System:- 

• Mapping/Relationship of logical file address to physical disk address. 

• Management of disk space allocation and deallocation. 

• Keeping track of all file system. 

• Support of protection and sharing of files recovery.  

 

 

1 1 0 0 0 0 0 1 

Byte Byte Byte Byte Byte Byte Byte Byte 



Disk organization for file system:- 

 Information on disk is referenced by multi-part address which includes the drive number, the surface and 

 track. 

Storage Mechanism In Magnetic Disk:- 

 In magnetic disk data stored in the form of logical circular tracks and sectors. 

 

 

 

 

Circular tracks logical 

 

 

 

 

 

 Sector logical 

 

Circular Tracks and sectors 

One Sector=512 Bytes 

 

 

Access Time:- 

 Seek Time. 

 Latency Time. 

For read and write, operation head is needed. There are two types of head 

❖ Fixed head. 

❖ Moveable head. 

 

Seek Time:- 

 Time to position the head on a specific track is called seek time. 

Latency Time:- 

The time required by a sector to reach below the read/write head is called latency time. 

 

Storage Mechanism in hard disk:- 
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A sector is the smallest unit of information that can be read from or written to the disk. 

 Sectors varies from 32 bytes to 4096 bytes. Generally 75 to 500 tracks per disk surface. 

 

 

 

Access Speed Measurement:- 

 RPM (Rotation Per Minute) is used for measuring speed. 

RPM may be 3600, 7200, above 10000. 

 

Disk Space Management Methods:- 

 OS maintains a list of free disk spaces to keep track of all disk blocks which are not being used by any 

file. There are following two methods for disk space management. 

• Linked List 

• Bit Map 

Linked List:- 

 According to this method, free disk blocks are linked together by each free block pointing to the next free 

 block. 

   

 

 

 

 

 

 

 

 

 

 

Points to the linked list of free disk block. 

 

 

 

 End 

Bit Map:- 

 List of free disk spaces is implemented as a bit map or bit vector. Each block is represented by a single bit. 

0→ Marks as free block. 

1→Marks as allocated block. 

 

Example:- 

111011010001010 

 

Disk Allocation methods:- Important 

 

For effective utilization of disk space we think about allocation methods. There are following two methods are 

used:- 

• Contiguous allocation method 

• Non Contiguous allocation 

o Linked list Allocation/Chaining Allocation 

o Indexed allocation 
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Linked list/Chaining:- 

 It is essentially a disk based version of the linked list.namely, a few bytes of each disk block are set aside 

to point to the next block in sequence. 

Both files and free space lists can be handled in this way. 
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Indexed Allocation:- 
 It is alternative implementation of non contiguous allocation of secondary storage space.It attempts to improve 

speed of random access by collecting pointers into the index blocks. This index block contains pointers to data block of 

related file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Contiguous Allocation:- 

According to this method files are assigned to contiguous areas of secondary storage. If the desired 

amount of contiguous space is not available, the file can not be created. 

 

 

File Start Size 

File1 3 4 

File2 8 3 

File3 13 5 

File4 19 6 

 

 

 

 

 

 

 

 

 

 

 

Disk Scheduling:- Important 

 To improve retrieving performance of disk is called disk scheduling. There are following  

 algorithm technique for disk scheduling. 

• FCFS Scheduling. 

• SRTF/SSTF Scheduling. 

• Scan Scheduling. 

• C scan Scheduling. 

• Look & C-Lookup Scheduling. 
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FCFS:- 

It is the simplest form of disk scheduling. In which the first request to arrive is the first one. It may not 

provide the best service. 

Example:- 

 A set of disk queue with requests involving tracks to read. 

 100,200,50,150,25,155,70 and 85 

The starting track to read is 100 and the least one is 85. 

Head at track 50. 

Solution:- 

Movement of disk head:- 

50→100→200→150→25→155→70→85. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SRTF:- 50→ 70→ 85→ 100→ 150→ 155→ 200→ 25 

 25→ 50→ 70→ 85→ 100→ 150→ 155→ 200 
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Scan Scheduling:- 50→ 70→ 85→ 100→ 150→ 155→ 200→ 25 

 

10→25 50→ 70→ 85→ 100→ 150→ 155→ 200 

 

 

 

 

 

 

 

 

 

 

 

 

C scan Scheduling:- 

 It is similar to SCAN scheduling,C-SCAN also moves head from one end to the other servicing all request 

 in its way.The difference here is that the head reaches the end it immediately returns to 

 beginning.,skipping all the requests on the return trip. 

Look and C Look  Scheduling:- 

These are just improvements of SCAN and C-SCAN but difficult to implement.Here the head  moves 

only till final request in each direction(First and Last ones) 

Security:- 

 Unauthorized access, destruction/revelation of data can violate individual privacy. 

 

Security threats and Goals:- 

 Following major security threats perceived by users and provides of computer based system 

includes. 

• Unauthorized disclosure of information. 

• Unauthorized alteration or destruction of information. 

• Unauthorized use of service. 

• Denial of service to legitimate users. 

 

Security Policies:- 

 Security policies specify what is desired in terms of protection and security. 

 

Security Mechanism:- 

 It specifies how to affect the security policies and enforce them in a given system. 

 

Penetration Attempts:- 

• Hit & Trial error Attempts. 

• Logged on Terminal. 

• Password. 

• Trapdoors:-These are the secret points of entry without access authorization 

• Trojan horse:-It is a program to steal user password.More sophisticated version of Trojan 

horse programs can make themselves harder to detect by fully emulating the utility that they 

are impostering. 

• Computer Worms:-It is a program to hack information via network and produce itself 

propagation. 

• Computer viruses. 

 

 

 

 

 



Breaches of Security:- 
1.Theft of PC & Media. 

2.Damage due to breakage. 

3.Environmental Damage. 

4.Inadvertental Corruption/Loss. 

5.Leakage of information. 

6.Modification or Erasures. 

Security Measures/Types:- 
1. Physical Securities:- 

  It is being used in offices.There are following precaution/awareness. 

  a) Physically bolt down the PC to a table. 

  b) Keyboard and PC should be locked 

  c) Keep all records into CD/DVD/BLU ray Disk/Pen drive/Memory Chips 

  d) These awareness must apply for server. 

  e) Protect against temperature and humidity. 

  f) Protect against power fluctuation. 

  g) Plug and wires should in proper manner. 

  h) Use vacuum cleaner at regular interval. 

2. S/W securities 

a) Use original s/w in computer. 

  b) Use correct procedures for shutting down the PC. 

  c) Keep back-ups of all files. 

3. Network Security 

The protection required for networked systems is much more extensive as physical 

security. Following precautions should keep for network security. 

❖ Keep the servers away and limit physical access to them. 

❖ Run server in background mode. 

❖ Some server provides auditing facilities. 

❖ Use OFC for highly sensitive networks. 

❖ Keep security against viruses. 

 

4. Password Security 

Some of the organizations or computer systems, then only authorization for data access is 

 giving the correct password, Rightly speaking, this is one step; the whole process would be: 

❖ Identification:-It identify user code indicates an object with a unique identity 

assigned to it. 

❖ Authentication:- 

The primary goal of authentication is to allow access to legitimate system users and 

deny access to unauthorized parties. Authentication is usually based on 

• Possession of a secret(password) 

• Possession of an artifact(Example card reader of ATM card) 

• Unique physiological or behavioral characteristics of the user (Based on Eye 

retina,Finger print, Heart bits, Voice based, facial characteristics etc. and 

Behavioral characteristics such as signature, Timing of keystrokes.) 

 

❖ Authorization:- This is passes user request to the matrix he is allowed access,  

Otherwise he is denied access to some parts of the database. 

Viruses:-Artificial Viruses(Vital Information Resource Under Seize) 
 It is computer program, which is used for performing unnecessary task. 

 Example:-WORM, Time Bomb, Trojan horse, Laden Mara Gaya, 28 Ferb Happy Birthday 

 Etc. 

Antivirus:- 
 It is used for protecting viruses. 

  Example:-Nortan Antiviruses, Spyware,Avast,Quick hell etc 
 



 

Source of Viruses:- 
 Internet, Pen Drive, 
 

Age old principles for Security policies:- 
• Least privileges. 

• Separation of duties. 

• Rotation in roles. 

When analysis is completed then following appropriate policies are defined. 

• DAC( Discretionary Access Control):- 

o Such policies are usually defined by the owner of data,who may pass access rights to others. 

• MAC (Mandatory Access Control):-Security defined by using level of authority. 

Example:- 

ATM (Level-1 Enter Card, Level-2 Enter Pin Number Then perform necessary function/task) 

 

 

Security Mechanism & Design Principles:- 
  Following general design principles for protection mechanisms. 

• Least Privilege. 

• Separation of privilege 

• Least common mechanism 

• Economy of mechanism. 

• Complete mediation 

• Fail safe default  

• User acceptability 

 

Authentication:- 
The primary goal of authentication is to allow access to legitimate system users and deny access to 

unauthorized parties. Authentication is usually based on 

• Possession of a secret(password) 

• Possession of an artifact(Example card reader of ATM card) 

• Unique physiological or behavioral characteristics of the user (Based on Eye 

retina,Finger print, Heart bits, Voice based,facial characteristics etc. and 

Behavioral characteristics such as signature, Timing of keystrokes. 

Protection and Access Control:- 

1. Protection in Computer System. 

 Physical protection (Protect by using lock and tight nut and bolt of furniture). 

 S/w Protection(Use original s/w rather than pirated) 

 Network protection (Keep away server & terminal from the ordinary user). 

2. Access Matrix Model of Protection 

 Access Hierarchies:-The concept of access hierarchy is not unique to H/W.It can also be used in S/W.For 

instance the scope rules of block structured programming languages. It is shown in following diagram 

   

 

 

  

 

 

 

 

 

 

 

 

Domain A 

Domain B 

Domain C 



Privileges decreases from A to C. 

 

 Access Lists:-All subjects having access rights to a particular object. 

  Example:- 

   Domain D1 for File1. 

    D1 (Read, Write, Execute Printer) 

   Domain D2 for File2. 

    D2 (Read, Execute Printer) 

 

 Capabilities or Tickets for objects:-It specify all access rights of a particular subject. 

  Example:- 

   In previous example list of domain D1 contain 

    Read(R) 

    Write (W) 

    Execute(X) 

  Capabilities provide a single, unified mechanism to 

➢ Address both Main Memory & Secondary memory. 

➢ Access both H/w And S/w resources. 

➢ Protect objects in both main and secondary memory. 

Access Matrix diagram:- 

 

 

 File1 File2 File3      Printer (Objects) 
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                                    D3 

 

 

 

Locks & Keys:- 

  It is a method of protection by using Key for locking objects. 

  Example:- 

   K1 L1 File1 

   K2 L2 File2 

   K3 L3 File3 

   K4 L4 File4 

   ……………………. 

   ……………………. 

   ……………………. 

   Ki Li Filei 

 

             Formal Model of protection:- 

➢ Access Control Matrix 

➢ The Take Grant Model 

➢ The Bell LaPadula Model 

➢ The Lattice Model of information flow 
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1:-Access Control Matrix:- 

 This model permits proof of various global properties of the protection system. It is modeled as  a 

 set of  subjects,S whose access rights to the set of objects. O,are expressed as Matrix A.It is defined 

 by triplet (S,O,A) 

 

 S Subjet 

 O Object 

 A Matrix 

Example:-1 

 Enter r into  A[s,o] 

 Delete r from  A[s,o] 

 Create subject s 

 Create object o 

 Destroy object o 

Example:-2 

Matrix A 

Subject                 Objects File1 File2 File3 

User1 r,w,x r x 

User2 r w r 

User3 x w rwx 

 

2:-The Take Grant Model:- 

 It is graph based model that describes a restricted class of protection system. This model defines the 

 protection as consisting of:- 

• A set of subjects 

• A set of objects 

• A set of generic rights (Such as Read( R ),Write(W),Execute(X),take(t) & grant(g)) 

 

Example:-1 

 Create subject (s) 

 Create  object (o) 

 Take (t) 

 Grant (g) 

 Remove (the access right) 

Example:-2 

 

Graph for take:- 

  

 Let A, B and C are three nodes. Suppose t is a prarameter for take, r is parameter for read and g is 

 parameter for grant. 

 

 

 t    r,g 

 

 

  

 

 

Graph for grant:-   r,g 
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Example:-3 

 Graph for take:- 
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 Graph for grant:- 
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3:-The Bell laPadula  Model:- (Multilevel Models) 

 Bell and LaPadula have devised a model of protection, named after them, that combines the access 

 matrix model with the classification hierarchy. The protection system is viewd as a set of subjects, a 

 set of objects & an access matrix.  

 State of protection system in this model given below. 

✓ Get access right. 

✓ Release access right. 

✓ Give permission to confer access right. 

✓ Rescind permission to confer access right. 

✓ Create object. 

✓ Delete object. 

✓ Change security level. 

 

 

A B C2 

E C3 

D C1 

E 

A B C2 

E C3 

D C1 

E 



Example:- 

 Read-Only:-Subject can read the object but not modify it. 

 Append :-Subject can write the object but can not read it. 

 Execute:-Subject can execute the object but can not read or write it directly. 

 Read-write:-Subject can both read and write the object. 

 

 

MAC (Mandatory Access Control):- 

 According to this method security classified into two categories. 

   1:- Secret 

   2:- Top Secret 

DAC (Discretionary Access Control):- 

 This model reduces burden of administrative security implementations. It is multilevel security 

 control system.It is much more flexible than MAC.   

Rule based Access Control:- 

 In this model access right roles are specific.Such as access for printers,Access for Modem,Access 

 for pre resources.   

Cryptography:- 

 It is a method of converting plain text into cipher text & cipher text into plain text. 

 

 Encryption method E        Decryption Method, D 

 

 P C P 

 

Plaintext Ciphertext Plaintext 

 

 

 

 

 Encryption Key K Insecure channel  Decryption key 

  

Encryption Method:- 

✓ DES (The data Encryption Standard) 

✓ RSA(The Rivest,Shamir,Adelman ) 

 

DES (The data Encryption Standard):- 

  It is 64 bits (8 Bytes) using block algorithm.The encryption process is parameterized by a user 

specified 56-bit key. The key spaces contain 56 bit value.It occupy 256 possible combinations. 

Every bit of the output block is a complex function of every bit in the input block & every bit in the key. 

DES steps are given as 

 

Step1:-  t=L0R0 

 

Step2:- Repeat for n=1 to 16 

  Ln= Rn-1 

  Rn= Ln-1f(Rn-1,Kn) 

Step3:- Output=t-1(L16R16) 

 

Where :- 

 t is initial transposition. 

 L0 Left half bit of 64 bits. 

 R0 Right half bit of 64 bits. 

 f Is computation function/Method. 

 K Key value. 

 

 

 

C=Ek(P) 

     

      P=D(C) 



Application:- 

✓ ATM pin  

✓ Credit Card Pin 

✓ UID number 

✓ Bar coding etc. 

 

 

RSA (The Rivest, Shamir, Adelman):- 

 This algorithm is based on modular arithmetic. One of the properties of modular arithmetic is the 

possibility of computing multiplicative inverse. 

Let given an integer e in the range [0, n-1], It is sometimes possible to find a unique integer d in the range 

[0,n-1] such that 

  ed mod n=1 

 

Example:- 

3 and 7 are multiplicative inverses modulo 20, because 21 mod 20=1. 

It can be shown that integer e [0,n-1] has unique multiplicative inverse mod n when e and n are 

relatively prime that is, when gcd (e,n)=1 

 

Consider n=p*q, where p and q are prime .A function (n) is defined as 

  (n)=(p-1)(q-1) 

 For a number P[0,n-1] it can be shown that the equation 

 

 C=Pcmod n………………………………………………… (1) 

 

 Is an inverse of  

  

 P=Cd mod n..………………………………………………. (2) 

 If 

    ed mod (n)=1 

 

RSA Algorithm steps:- 

Step 1:-Choose two large primes, p and q each greater than 10100 

Step2:-Compute n=pq and (n) = (p-1) (q-1). 

Step3:- Choose a number d to be a large, random integer that is relatively prime to  

  (n), that is, such that gcd (d, (n))=1. 

Step4:- Find e such that ed mod (n)=1. 

 

 Digital Signature:- 

 

   It  is a way of making an electronic message in a manner that is unique and provably 

traceable to the originator. 

Assuming that B receive a message M signed by A, the digital signature must satisfy the following 

requirements. 

 

  A(Sender)→→→B(Receiver) 

• It must be possible for B to validate A’s signature on M. 

• It must be impossible for anyone to forge A’s signature. 

• It must be impossible for A to repudiate the message M. 

 

  EA(DB( C )) = EA(DB(EB(DA(P)))) 

    = EA(DA (P)) 

    = P 



 

 

Viruses:-Artificial Viruses based on logic 
 It is computer program, which is used for performing unnecessary task. 

  

Example:-WORM, Time Bomb, Trojan horse, Laden Mara Gaya, 28 Ferb Happy Birthday Etc. 

 
The concept of virus dates back to 1949, when John Von Neumann submitted a paper putting forward 
the concept of a "Self Replicating" program; First virus is “CODE-WARS” Made at Bell Labs. 
 Or 
A virus is by definition a computer program that spreads or replicates by copying  
itself. There are many known techniques that can be used by a virus, and viruses  
appear on many platforms. However, the ability to replicate itself is the common  
criterion that distinguishes a virus from other kinds of software. 

Categories of viruses: 

1. BOOT Infectors. 

2. SYSTEM Infectors. 

3. GENERAL EXECUTABLE PROGRAM Infectors. 

 

The existence of a computer viruses typically encompasses four stages. 

• Dormancy (Creation of Virus stage). 

• Propagation ( Spreading from one device/Terminal to another device/Terminal). 

• Triggering (Automatic fire in system). 

• Damage. 

Example of Some Viruses:- 

1:-Scores Virus:- Such viruses has a built in time trigger that activates at two,Four and Seven days after disk has 

became infected. 

2:-Brain Virus:-It is also known as the Pakistani virus. It has developed by Pakistani brothers. It displays a 

message on screen known as “Welcome to Dungeon”. 

3:-Lehigh Virus:-It was developed from Lehigh University computer center. This virus stays in stack space of 

Command.com.Such virus can not execute any Internal and external MS Dos command. 

4:-Friday the 13th Virus:-Such virus also attack command.com as well as .Exe file 

5:-Sunnyvale Slug Virus:-It displaying a message “Greeting from Sunnyvale. Can you find me?” 

6:-Raindrops Virus:-It infects .com files. It interprets the load and executes function of MS DOS. 

7:-Happy Birthday 30th:-This virus gets activated on January 5th,if any of infected program executed and ask ,the  

user to type “Happy Birthday 30 th”. 

 

Some Other Example of Viruses:- 

 Marijuana, Joshi, Flip, Eddie, Serum, Kinky, Zealot, Frodo, DesiDatalock, V2000, Frodo, Gravity, 

 Liberty, Pronto etc. 

WARM:- 

A pure worm is more independent than a virus. A pure worm works by itself as an  

Independent object. It does not need a carrier object to attach itself to. The worm  

can also spread by initiating telecommunications by itself. There is no need to wait  

for a human to send the file or document. 

 

Prevention:- 

 Do not use pirated copy. 

 Away from unauthorized person. 

 First scan pen drive before using.  

 Do not download suspicious shareware programs. 

Cure (Permanent Treatment):- 

 Prevention 

 Detection 



 Vaccination 

 Damage control 

 Identification 

 

 

 

 

Multiprocessor System:- 

 A collection a number of standard processors put together in an innovative way to improve 

 performance/speed of computer hardware. 

 There are two way by which to increase speed of system 

• High speed components. 

• Architecture design. 

 

Advantage of Multiprocessor system:- 

• Increased system throughput 

• Application speedup 

• Fault tolerance 

• Performance and computing power 

• Modular growth 

• Cost/Performance 

Classification of Multiprocessor:- 

 According to M.J. Flynn’s, Computers are classified four categories. 

✓ SISD(Single Instruction Single data). 

✓ SIMD(Single Instruction Multiple data). 

✓ MISD(Multiple Instruction Single data). 

✓ MIMD(Multiple Instruction Multiple data). 

SISD:- 

 Using this technology, Single Instruction applies on single data stream through pipeline. 

 Example:-Conventional Von Neumann architecture. 

SIMD:- 

 Using this technology, Single Instruction applies multiple data stream or Instructions broadcast on 

 multiple data stream. 

 Example:-Array Processors. 

MISD:- 

 Using this technology, Multiple Instruction applies on single data stream. 

 Example:-Distributed architecture, Vector Processors. 

MIMD:- 

 Using this technology, Multiple Instruction applies on multiple data stream. 

 Example:-Multiprocessor System, Data Flow architecture. 

  

Processor Coupling:- 

 Multiprocessors design are classified into two categories. 

• Tightly coupled:-It uses global shared memory for multiprocessors. 

• Loosely coupled:-It uses individual private memories. 

Multiprocessor Interconnections:- 

• Bus Oriented System. 

• Crossbar Connected System. 

• Hypercube. 

• Multistage switched based system. 

Bus Oriented System:- 

 It is the simplest ways to construct a multiprocessor is to use a shared bus to connect processors and 

 memories 
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Crossbar Connected System:- 

  The crossbar itself has no contention. It allows simultaneous access of N processors to N   

  memories, Provided that processor accesses a different memory. 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 The cross point switch is the source of delay between a processor and memory. When more than 

 one processor attempts to access the same memory at the same time. The crossbar scheme allows 

 high degree of parallelism between unrelated task.It requires N2 crosspoint switches to fully  

 connect N endpoints to N other end points, such as processors and memory. 

Hyper cubes System:- 

  Such types of multiprocessors connecting system shown in following figures. 
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Multistage Switch based System:- 

  Processors and memories in a multiprocessor system can be connected by means of  a multistage 

switch. There are many variations of this approach.A generalized form of this type of interconnections 

provides links between N inputs and N outputs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Multistage switching networks provide a form of circuit switching. The multistage switch can simultaneously 

connect all inputs to all outputs. Provided no two processors attempt to access the same memory module at the 

same time. It reduces contention between memory and processors. 

 

Types of Multiprocessors OS:- 

  There are three basic types of multiprocessors OS. 

• Separate supervisors 

• Master/Slave 

• Symmetric 

 

Separate Supervisors:- 

  In separate supervisor systems, each node contains a separate OS that manages local processors,  

  Memory and I/O resources. It is uses in Hypercube multiprocessor system. 

 

Master/Slave Supervisors:- 

  In the master slave approach, one processor is dedicated to executing the OS.The remaining  

  processors are identical  and form a pool of computational processors.
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Symmetric OS:- 

 

  In this organization, all processors are functionally  identical.For allocation purposes, they  

  represent a pool of anonymous resources.Other H/W resources such as memory and I/O devices  

  may also be pooled so as to be available to all processors. 

 

Multiprocessors OS functions and requirements:- 

 The three basic types of resources that need to managed are:- 

 Processors Management. 

 Memory Management. 

 I/O Devices Management. 

 

Processor scheduling:- 

 Effective use of multiprocessors is called processors scheduling.The primary tasks of multiprocessors 

 schedulers are to:- 

 Allocate processors among applications in a manner consistent system design objectives. 

 Ensure efficient use of processors allocated to an application. 

Memory management:- 

 Multiprocessors is highly dependent on the underlying architecture and interconnection scheme. 

 There are two way by which memory management in multiprocessor. 

 Loosely coupled.(Handle independent memory). 

 Tightly coupled.(Handle GSM memory). 

 

I/O Devices management:- 

   Input→Process→Output 

 I/O Peripherals /Devices 

 I/O Modules (It is a mediator which is used for transferring from I/O to CPU). 

 I/O Technique. (The I/O operations can be performed by three basic techniques) 

 I/O Processors. 
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   Distributed OS algorithm:-  

What is distributed computer System:- 

It is a collection of autonomous computer system capable of communications and cooperation via there h/w and 

s/w interconnections.It is characterized by the absence of shared memory. 

What is distributed OS:- 

A distributed OS governs the operation of distributed computer system and provides a virtual  machine system 

abstraction to its users.The key objective  of a distributed OS is transparency. 

Why Distributed:-  

Its major potential benefits includes:- 

 Resource shairing and load balancing. 

 Incremental growth. 

 Better performance. 

 Reliability, availability and fault tolerance. 

 Communication & Information shairing. 

What is Distributed:- 

 Hardware Distribution. 

 Control Distribution. 

 Data Distribution. 

 

Distribution Network Technology:- 

 LAN 

 WAN 

LAN (Local Area Network) 

A Local Area Network is a network that connects computers and devices in a limited geographical area such as 

home, school, computer laboratory, office building, or closely positioned group of buildings. 

Characteristics: 

 A diameter not more than a few kms. 

 A total data rate of at least several Mbps. 

 Complete ownership by a single organization. 

WAN (Wide Area Network) 

A (WAN) is a computer network that covers a large geographic area such as a city, country, or spans even 

intercontinental distances, using a communications channel that combines many types of media such as telephone 

lines, cables, and air waves. 

Characteristics: 

✓ More scalable than LAN and WAN. 

✓ Connects many sites spread across large geographic distances with many computers at each site. 

✓ Provides sufficient capacity to permit the computers to communicate simultaneously. 
 

Distributed Network Topology:- 

A topology is the layout of the network components or the pattern of arrangement of nodes that are 

connected using cables in a local area network (LAN) environment. There are following study of 

network topology recognizes eight basic topologies 

1- Bus Topology. 

2- Ring/Circular Topology. 

3- Star Topology. 

4- Tree Topology . 

5- Mesh Topology. 

6- Point-to-Point Topology. 

7- Daisy Chain Topology. 

8- Hybrid Topology. 

 

Bus Topology:- 

  T1  T2  T3 T4 



 

 

 

 

 

 

 

 

 

✓ : In this topology, the computers are connected to form a network through a single cable that runs from 

one computer to another. Each node can send messages(Tokens) to all the other nodes in the network. If 

a node sends a message to a particular node in the network, only that node accepts the message and all 

the other nodes ignore it. 

Ring/Circular 

 

 

 

 

 

 

 

 

 

 

Ring Topology: In this topology, each computer is connected to the computer next to it, Hence, each 

computer is connected only to two of its neighboring nodes. All the components of the network are 

connected to a main cable and form a circle. When a node sends a message to any other node on the ring, 

the message travels (either in clockwise or counter clockwise direction) through every other node in the ring 

until it reaches its destination node. In this topology, the data is transmitted in one direction and if one node 

fails to transmit the data the entire network fails. 

 

Star Topology:- 

 

 

 

 

 

 

    Switch or a hub 

 

Star Topology: In this topology, all the computers are connected to a central device. The central device can 

be a switch or a hub. The central device is usually connected to the server and it receives the data from a 

node and sends it to the destination node. 

 

 

 

 

Tree Topology:- 

  Tree topology is the combination of Bus and Star topology. 
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Mesh Topology:- 

 Every computer has a direct connection to every other computer on the network.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Point-to-point (telecommunication)  

In telecommunication, a point-to-point connection refers to a communications connection between two 
nodes or endpoints. An example is a, in which one telephone is a connected with one other, and what is 
said by one caller can only be heard by the other. This is contrasted with a communication topology, in 
which many nodes can receive information transmitted by one node. 
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Hybrid 

Hybrid networks use a combination of any two or more topologies. A Star Bus network consists of two or more 

star topologies connected using a bus trunk (the bus trunk serves as the network's backbone). 

 

Switching of computer Network:- 

1. Circuit Switching:- (Physical dedicated connection established between sender and receiver for 

communication). 

2. Message Switching:-(Physical connection established between sender and receiver during 

communication session). 

3. Packet Switching: -(It is logical channel for communication. There are two types of packets 

switching) . 
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   A: - Datagram circuit:- (There are many logical paths for sending and    

   receiving packets) 

   B: - Virtual circuit:-There is only a single logical dedicated path established   

   between sender and receiver) 

 

 Note:- 

  TCP/IP protocol is used for packet switching. 

 TCP:- It is used for making discrete messages and resembling at destination. 

 IP:- It is used for allocating destination address on each packet. 

 

Distributed Network Model:- 

  There are two types of network models are used for making distributed network. 

1. OSI →(Open System Interconnections) Model 

2. TCP/IP→(Transmission Control Protocol/Internet Protocol) Model 

 

OSI Model(Open System Interconnection) 

It consist of hierarchy of 7 layers 

▪ Physical Layer→Bits Orientation Layer. 

▪ Data Link Layer→Frames Orientation Layer. 

▪ Network Layer→Addressing Layer. 

▪ Transport Layer→It transmits frames from source to destination. 

▪ Session Layer→Accumulate all incoming frames in specific session. 

▪ Presentation Layer →Resembled all frames into original message. 

▪ Application Layer→It is a layer where user access service of network. 

❖ TCP/IP Model(It is used in wireless  network) 

o It consists of five layers used in wireless media. 

▪ Physical Layer→Bits Orientation Layers 

▪ DLL→Packets(Discrete messages) orientation Layers  

▪ Network Layers→Addressing on each packets. 

▪ Transport Layers→Transmission of packets from source to destination. 

▪ Application Layers→ It is a layer where user access service of network. 

Concurrency Control algorithm In Distributed network:- Most Important Chapter 

  

Time and ordering of Events:-Lamport Scheme 

 Step-1 Let a and b are events in the same process and a comes before b, then a→b 

 Step-2 If a represents the sending of message by one process and b the receipt of the same  

  message by another process, then a→b 

 Step-3 The relation is transitive. 

  That is, if a→b and b→c then a→c 

 



Clock Condition:- 

  For any events a and b: if a→b, then C(a)<C(b) 

 C1:- If  a and  b are events in process Pi  and a comes before b,then  Ci(a)<Ci(b)  

 C2:- If  a  is the events of sending a message m by process Pi and b is the receipt of that message by process 

  Pj then Ci(a)<Cj(b). 

Condition C1 and C2 can be satisfied by implementing the logical clocks so that the following conditions holds. 

✓ Process Pi increments its logical clocks Ci between any two successive events. 

✓ Messages are time stamped by the sending process in the following way. If event a is the sending of message m by 

process Pi ,Then the message m contains the time stamp. 

  Tm=Ci(a) 

✓ The receiving process adjusts its logical clock upon receipt of a messages follows. Upon receipt of a message 

m, process Pj then sets Cj to max(Cj+1,Tm). 

Distributed concurrency control:- 

Wait-die:- 

 If the requester is older than the transaction that owns the desired lock→the requester→ waits otherwise, 

 the requester dies. 

Wound -Wait:- 

 If the requester is older than the owner of the lock, the requester wounds the owner.Otherwise, the requester 

 waits. 

ping-pong algorithm:- 

 Let us call the two tokens pings and pong.The value of each token ,nping and npong respectively,counts the 

number of times the two tokens have met.For convenience ,the values of two tokens have opposite signs.Initially, 

token values set as follows:- 

nping=1 

npong=-1 

The two tokens circulates around the ring in opposite directions.Its numeric values sum will be zero. 

ie nping+npong=0 

Algorithm Steps:- 

✓ When the two tokens meet at a node, it sets their associated values as follows    

   nping=nping+1 

 npong=npong-1 

✓ When a node i receives the tokens(ping,nping),It act as follows 

a) if ni≠nping  the nodes sets ni=nping and relays the tokens otherwise 

b)  if ni=nping the pong token is lost and needs to be regenerated.The node sets 

   nping=nping+1 

   npong=- nping 

It sends the token along:send(ping,nping) and sends(pong,npong). 

Lamport Algorithm:- 

 Assuming the presence of the pipelining property and eventual delivery of all messages, the solution 

requires time stamping of all messages and it is also assumes that each process maintains a request queue, initially 

empty, that contains request messages ordered by the relations ═>.The algorithm is defined as. 

 

Step1:-When process Pi desires to acquire exclusive ownership of the resource, It sends the time stamped message 

 request (Ti,i) where Ti=Ci  

Step2:- When process Pj receive the request (Ti,i) message, it places the request on its own queue and sends a 

 message (Tj,j) to process Pi. 

Step3:-Process Pi is allowed to access the resource when the following two conditions are satisfied. 

 [a] Pi’s request message is at the front of the queue. 

 [b] Pi has received a message from every other process with a time stamp later than (Ti,i). 

Step4:- Process Pi releases the resource by removing the request from its own queue and time by sending a time 

 stamped release message to every other process. 

Step5:- Upon receipt Pi’s release message, process Pj removes Pi’s request from its request queue. 

 



Concept of GUI(Graphical User Interface) Based OS:-  Most Important 

  It works on the principal of WYSIWYG (What You See Is What You Get). 

 It includes following features. 

❖ Common Look And feel. 

❖ It facilitates user-friendly environment. 

❖ It manages resources of computer. 

❖ It supports MS Dos.(Microsoft Disk Operating System). 

❖ It provides windows environment. 

 

Common Graphical user Interface:- 

❖ Pointing devices. 

o Mouse. 

o Joystick (It is used for playing computer game). 

o Track ball. 

o Light Pen. 

❖ Pointer. 

❖ Windows. 

❖ Menus. 

❖ Dialog Boxes. 

❖ Icons. 

❖ Desktop Metaphor (The idea of metaphors has brought the computer closure to natural 

environment of the end user). 

❖ It facilitates object oriented features. 

 

What is Windows:- 

 

 It is rectangular portion of screen where one can work in user-friendly environment.Windows appear on 

 desktop screen. Which is handled by mouse technique , keyboard technique & touch technique. 

Elements of Windows:- 

❖ Icons. 

❖ Title Bar. 

❖ Maximize. 

❖ Minimize. 

❖ Close. 

❖ Menu bar. 

❖ Status Bar. 

❖ Control Menu Box. 

❖ Window Border. 

❖ Work area. 

❖ Desktop. 

❖ Cursor/Insertion Point  

❖ Pointer(). 

❖ Tiled Windows. 

❖ Cascade Windows. 

 

 

 

 

 

 

 

Simple Structure of Windows:- 
Title Bar 



  

 

 

 

 

 

 

 

 

 

 

 

 

 

Types of Windows:- 

✓ Applications Windows. 

✓ Document windows. 

 

Application Windows:- 

  It consist of its own title bar and menu bar such as  

✓ MS Word. 

✓ MS EXCEL. 

✓ MS Power Point. 

✓ Notepad. 

✓ Word Pad. 

✓ Window Media Player. 

  Etc. 

 

Document Windows:- 

 It appear inside an application windows which contain files informations, 

folder information, s/w information etc.It has own title bar but share menu bar with application 

windows. 

 

Icon:-It is small graphical picture associated with files, folders, images,s/w etc. 

 

 

 

 

 

 

 

 

Control Menu Box:- 

It appears upper left corner in each windows. Which consist of following six options? 

❖ Restore. 

❖ Maximize. 

❖ Minimize. 

❖ Close. 



❖ Move. 

❖ Size. 

  

Desktop:- 

 It is background portion where windows appear is called desktop. 

 

Menu bar:-  

 It consists of list of available menus. 

Menu:- 

 It consists of commands and options. 

Title Bar:- 

 It indicate name of application s/w. 

 

Working Technique With Windows:- 

1:- Mouse technique 

 a) Click b) Double Click c) Drag d) Drag & Drop e) Point  

2:-  Keyboard Technique:- 

 Alt+Space+R  Restore Size of Windows. 

 Alt+Space+X  Maximize Size of Windows. 

 Alt+Space+N  Minimize Size of Windows. 

 Alt+Space+Tab  Minimize To Maximize/ Minimize To Restore. 

 Alt+ F4   Close Windows. 

 F1    Help of related Windows. 

 Alt+Underline Character Open Menu. 

 Tab    To Select Item. 

 Alt/F10   To Select Menu. 

 Alt+Space   Open Control Menu Box. 

 Ctrl+C   Copy.    

 Ctrl+X   Cut. 

 Ctrl+A   Select All. 

 Ctrl+Z   Undo. 

 Ctrl+Y   Redo. 

 Ctrl+N   New File 

 Ctrl+O   Open File 

  

Concept of Files and Folders/Directories:-   

 

File:- 

It is collection of related information. File is the heart of any application s/w. 

Computer file name must be associated with two parts. 

a) Primary File name (Given by user). 

b) Secondary file name (Extension name given by user & System both). 

Rule for primary File name:- 

❖ File name should start with alphabet characters. (A to Z or a to z). 

❖ File name should be small and logical. 

❖ Files should be kept in proper manner, using folders and disk drives. 

 

Secondary File Name/Extension Name:- 



  It is used for specific purpose. Such as searching a group of files, deleting a group of 

files, copyinig a group of files, renaming a group of files.Some of reserved extension names are 

given below. 

  .doc →→→ document files(MS Word/Word Pad). 

  .xls →→→ work sheet files (MS Excel). 

  .ppt →→→ PowerPoint files. 

  .mdb →→→ ms access files. 

  .bmp →→→ bitmap picture files/Paintbrush. 

  .gif →→→ graphics files. 

  .jpg →→→ image files. 

  .html →→→ web page files. 

  .txt →→→ Text files(Note Pad). 

  .sys →→→ System files. 

  .prg →→→ Program files. 

  .tmp →→→ Temporary files. 

  .cdr →→→ Coral draw files. 

  .pdf →→→ Adobe file. 

  .mp3 →→→ Audio Files. 

  Etc. 

Wild Cards:- 

 * It represent  all characters. 

 ? It represent any one character. 

Example based on searching:- 

❖ To search all files of MS Word in system. 

*.doc 

❖ To search all files  of MS PowerPoint in system 

*.ppt 

❖ To search all files  of MS Excel in system 

*.xls 

❖ To search all files  of Web page in system 

*.htm 

❖ To search all files  of database(MS Access) in system 

*.mdb 

❖ To search only those file which begin with character ‘a’ & rest are any characters of word. 

a*.doc 

❖ To search all files which first character is any character followed by ‘a’ and rest are any 

character of ms excel. 

?a*.xls 

❖ To search all files which first character is any character followed by ‘a’ and  third character 

must be ‘n’ & rest are any character of ms word. 

??n*.doc 

❖ To search all images in system. 

*.jpg 

❖ To search all graphics in system. 

*.gif 

 

Application of MS Windows:- 

1. Desk Top Setting:-Press Right Button On Desktop Screen→ Click Properties 



 

1.1. Screen saver. 

1.2. Background Setting. 

1.3. Appearance. 

1.4. Themes. 

2. Date And Time Setting:-Start→ControlPannel→Date & Time Setting 

 

3. Accessories 



3.1. Paint Brush S/w:-Start→Program→Accessories→Paintbrush 

 

3.2. Notepad S/W:-Start→Program→Accessories→Notepad 

 

 



3.3. Word Pad S/W:-Start→Program→Accessories→Wordpad 

 

3.4. Calculator:-Start→Program→Accessories→Calculator 

 

 

3.5. Games(Entertainment) :-Start→Program→Game→Select Game 

 

3.6. Windows Media Player(Entertainment) :-

Start→Program→Accessories→Entertainment→Windows media Player 

3.7. System Tools(It is used for troubleshooting of system) 

  Start→Program→Accessories→System Tool→ 

3.7.1. Scandisk → (Check error and remove Hard disk problems) 

3.7.2. Disk clean up→ (Remove unnecessary files) 

3.7.3. Character Map → (Contain symbols and special characters) 

3.7.4. Backup → (Make an additional copy) 

3.7.5. Disk defragementation→ ( Consolidate Unused memory) 

4. Creation of Folders(We can create folder any where in system) 

5. Desktop Items  

5.1. My Documents. 

5.2. Recycles Bin/Trash Bin. 

5.3. My Computer. 

5.4. Internet Explorer( For accessing Internet Service) 

6. How to play music. 

6.1. Through Media Player. 



6.2. Through WIN AMP/Jet Audio Media Player. 

7. How to copy files and folders from one location to another. 

7.1. CD to CD. 

7.2. CD to Hard disk. 

7.3. Hard disk to CD. 

7.4. CD/Hard Disk To Pen Drive. 

8. Control panel. 

8.1. Mouse Setting Property:- Start→ControlPannel→Mouse Setting. 

8.2. System Checking:- Start→ControlPannel→System. 

8.3. Font Loading: - Start→ControlPannel→Font. 

8.4. Add/Remove H/W:- Start→ControlPannel→Add/Remove H/W. 

8.5. Add/Remove S/W:- Start→ControlPannel→Add/Remove S/W. 

8.6. User’s Account(Creation and deletion) :- Start→ControlPannel→User’s 

Account 

9. Log off/Log On. (Close/Open All→ Open/Closed internal files →but computer remain on) 

10. Shutdown/Turn off & Restart. 

Booting Process/Starting up system:- 

 It is the process of loading operating system in to main memory of computer. 

During booting session, OS checks following components. 

 a) Memory Checking. 

 b) I/O system Checking. 

 c) CPU checking. 

 d) Files System checking. 

Types of Booting:- 

 Cold Booting (Initial Starting of Computer System). 

 Warm Booting (Alt+Ctrl+Del/Direct Restart)/Press Reset Button. 

 

Clipboard:- 

It is temporary buffer (Temporary Memory), which is used for containing cut/copies 

matters/Contents. 

 

Control Panel:- 

 It helps in the setting of H/W and S/W components according to our need. 

 Start Setting Control Pannel 

 Work/Function in Control Pannel:- 

❖ Display/Background. 

❖ Date & Time. 

❖ Mouse Setting. 

❖ System information. 

❖ User Account. 

❖ Font installation. 

❖ H/W and S/w Installation and Deinstallation. 

❖ Sound and VGA Installation & Deinstalation. 

 

Macintosh Toolbox:-It is GUI based  s/w which was developed from Apple’s Lisa. It consist of 

collection of utilities to manipulate Macintosh’s resources.Following functional overviews in  

 

     Or 



The Mac OS X (Operating System Ten):- 

Mac OS X is the newest in a long line of Graphical User Interface (GUI) operating systems, first started in 1984 

(when the Apple Macintosh was introduced). The Macintosh and its operating system were based on the work 

done at Xerox PARC (Palo Alto Research Complex), but not commercialized by Xerox.  

Microsoft's Windows also has its roots in the first Mac (and Xerox) operating systems. 

Mac OS X Terminology 

Here are a few important terms that you must know to be able to understand the rest of the 

information on this page. 

Desktop:-     

                      

      

The entire screen, which contains the Dock, Toolbar, Icons, 

and Windows. 

The sequence of Icons that appears centered at the bottom 

of the Desktop. The following picture shows how the Dock 

might appear.  The specific applications that appear in the 

Dock will vary from computer to computer and user to user. 

Dock:- 

 

   

Macintosh toolbox.  

❖ Fonts manager 

❖ Event manager 

❖ Desk Manager 

❖ Text Edit 

❖ Memory Manager 

❖ File Manager 

❖ Silver Driver(For Music) 

 

X Windows:- 

It is GUI based application.But can not provides user interface components such as 

buttons, menus or dialog boxes. 

 

X-windows Development Environment:- 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  Xt Intrinsics:- 

   It provides a framework that allows the programmers to combine the components. 

Application 

Widget Set 

Xt Intrinsics 

X lib C language Interface 

X server 

Network Connection 



Widget set:-It inherit (Reusability) from the meta (description of data about data) 

class and most composite widgets inherit from the manager widget class. 

  Note:-It provides interface with c compiler to do programming. 

Advanced Application of Windows:- 

MS Word. 

MS Power Point. 

MS Excel. 

MS Access. 

MS FrontPage. 

Coral Draw. 

Photo Shop. 

Page Maker. 

Etc.  

Advanced MS Office:- 

It is integrated office automation package.It can perform following tasks/functions. 

❖ MS Word (It is word processing s/w). 

❖ MS Excel (it is used for performing calculations and making reports). 

❖ MS PowerPoint (It is used for making presentations). 

❖ MS Access (it is used for managing database). 

❖ MS Frontpage (It is used for making web page). 

❖ Internet Explorer (It is used for surfing internet service). 

❖ MS Outlooks (It is used for sending and receiving E-Mail) 

 

Introduction of MS Word: - (Extension/Secondary File name .doc) 

It is a word processing s/w which is used for performing following tasks. 

❖ Creation of document. 

❖ Deletion of document. 

❖ Creation of template. 
❖ Creation of table. 

❖ Creation of macros. 

❖ Creation of Mail merge. 

❖ Spelling and grammar checking. 

❖ It provides OLE features. 

❖ It provides finding and replacing. 

❖ It facilitates different types of fonts and their effects. 

❖ It facilitates headers and footers. 

❖ MS word provides facilities of drawing features. 

❖ It provides bullets and numbering. 

❖ We can set password in document. 

❖ Setting indents features (Increase and decrease). 

❖ It facilitates equation editors. 

❖ Autocorrect feature. 

❖ Border facility. 

❖ It facilitates Zoom in and Zoom out features. 

Etc. 



 

Commands Used in MS WORD:- 
Ctrl+Shift+*  Display non-printing character. 

Ctrl+Shift+>  Increase font Size. 

Ctrl+Shift+<  Decrease font size. 

Ctrl+]   Increase font. 

Ctrl+ [   Decrease font. 

Ctrl+Enter  Break page/Enter New Page. 

Alt +Ctrl+R  Register trademark Symbol.® 

Alt+Ctrl +.  Make ellipsis.(…) 

Alt+ Ctrl +C  Copyright symbol. © 

Alt+Ctrl+T  The Trademark Symbol. ™ 

Shift+F1   Context sensitive help. 

Shift+ F2   Copy text. 

Shift+f3   change case. 

Shift+F4   Repeat a find or goto action. 

Shift+F7   Choose Thesaurus commands. 

Shift+F8   Shrinking documents.  

Shift+F10  Display a shortcut menu. 

Shift+F12  Choose the save as commands. 

Alt+Ctrl+M  Insert a comment. 

Alt+Ctrl+1  Apply the leading 1 style. 

Alt+Ctrl+2  Apply the leading 2 style. 

F7    Open Spelling and grammer checking. 

Ctrl+K   Hyperlink. 

Ctrl+W   Close file. 

      Alt+F+A   Save As. 

      Ctrl+F2   print.  

  Alt+F+U   Page Setup. 

 Alt+F+D   Mail Recipients. 

 Ctrl+F   Find Dialog Box. 

 Ctrl+G   Replace. 

 Alt+V+T   Toolbar. 

Alt+V+H   Header & Footer. 

Alt+V+Z   Zoom. 

Alt+V+U   Full screen.    

Etc. 

 

Concept of Headers & Footers:- 
Headers:- 

It appears top of each page is called headers. 

Headers may be:- 

❖ Page Numbers. 

❖ Number of pages. 

❖ Date & Time. 

❖ Drawing object. 

❖ File name. 

❖ Images. Etc. 

 



Footers:- 
It appears bottom of each page is called footers. 

Footers may be:- 

❖ Page Numbers. 

❖ Number of pages. 

❖ Date & Time. 

❖ Drawing object. 

❖ File name. 

❖ Images. 

Etc.  

OLE (Object Linking and Embedding):- 
   It is a way of attachment of word file in the form of linked object or embedded 

object. In case linked object original file must be change or effected and in the case of embedded 

object, original file does not change or affect. 

Steps for Linking:- 

Insert→Object→Create New File→Check Link & Icon→Browse→Select & Open File. 

Steps For Embedded:- 

Insert→Object→Create New File→Check Icon→Browse→Select & Open File. 

Bullets & Numbering:- 

Bullets:- Bullets are symbols, graphics, and images for displaying  

unordered items. 

Numbering: -It is used for displaying ordered list of items. 

   It may be 

1. Numbers. 

2. Romans. 

3. Alphabets(Upper case and Lower case). 

Change case(Press F3):- 

  It Is Used For Changing Cases. There are many types of cases. 

❖ Upper case.  

❖ Lower case. 

❖ Title case. 
❖ Senetence Case. 

❖ Toggle case. 

Format→Change Case. 

Example of Uppercase:- 

 RAM IS A GOOD BOY 

Example of Lowercase:- 
 ram is a good boy 

Example of Sentence case:- 

 Ram is a good boy 

Example of Title case:- 

 Ram Is A Good Boy 

Example of Toggle case:- 

 rAM iS a gOOD bOY 

 

 
 

 



Mail Merge:- 

Mail merge feature is a quick and easy way for mass/Bulk producing letters, forms, 

envelopes, mailing labels etc. 

Tools→Mail Merge. 
Macros:- 

It is a sequence of actions that is named and stored. When we run a macro, word performs 

all the assigned actions in a sequence. It provides faster editing and formatting. 

ToolsMacrosRecord New Macro(Assigned Into Commands/Tool). 

ToolsMacrosStop Macro Commands. 

ToolsMacrosRunMacro_Name(For running Macros). 

Templates(Designed by User):- 

A standard design or page format is used over and over again to give a consistent 

appearance to a series of documents. 

 
Templates Wizards (Already Made in system):- 

A technique used by some applications to guide the inexperienced or infrequent user 

through a complex set of steps by asking questions about the document they are in the 

process of creating as they are actually creating it. 

Wizard can take the form of dialog boxes containing a set of choices for each stage of 

creation process or they can also appear as animated on screen assistant  who offer help 

from time to time. 

Table:- 

 It consists of rows and columns. 

 

Number of rows=4. 

Number Of columns=5. 

 
Hyperlink:- 

 It is used for linking one document with other document. 

 

Drop caps:- 

It is used for writing first character in highlighted form or big size corresponding 

many lines.  

     

     

     

     



 

 

 

 

 

 

 

 

 
Font:- 

 It is a way of writing contents or matters by different ways. 

Example:- 

  Times New Roman, 
  Showcard Gothic. 

  Algerian Etc. 

Figure:- 

 



Paragraph:- 
 It consists of a lot amount of sentences. After pressing enter key a new 

 paragraph created. 

 Pattern 1 paragraph (Hanging Style) 

  …………………………………. 

   ……………………………. 

   ……………………………. 

   ……………………………. 

 Pattern 2 paragraph (First Line Style) 

    ……………………… 

   ……………………………. 

   ……………………………. 

   ……………………………. 

Border & Shading:- 

  

 

 

 

 

 

 

 

 

 

 

 

Spelling & Grammer Checking:-( It is editing & proofing tool) 

 



 

Customize- 
  BY using, this feature of MS word, we can create own toolbar   

  and menu.This option available in tools menu. 

  Tools→Customize→Command→New Menu. 

Equation editor:- 
  This option facilitates for writing mathematical based symbols,   

  equations etc. 

  Tools→Customize→Command→Insert→Equation Editor. 

 

 Example :-1 
    ⎯⎯ →⎯+ = 2.963 yyx  

  

Example :-2 
=

n

x

xdx
1

 

 

 

Tab 

 It is used for setting stop position of cursor. Default tab stop is .5 inch. 

 There are following types of tab stop. 

❖ Left Tab   L 

❖ Right Tab  ┘ 

❖ Center Tab   

❖ Decimal tab   . 

❖ Bar tab 

Dialog Box:- 



Find & Replacing:- 
It is used for finding character, word in a given document and replaces it by 

desired characters or words. 

 

  

 

 

 

 

 

 

 

Printing In MS Word:- 

   It produces out put on paper. It is called hard copy. 

Before printing of document we follow following steps. 

Step1:- Page Setup.   Alt+F+U 

Step2:- Print Preview.   Ctrl+F2 

Step3:- Printing of document. Ctrl+P 

 

Page Setup:- 

  Margin:- 

a) Left Margin. 

b) Right Margin. 

c) Top Margin. 

d) Bottom Margin. 

e) Gutter Margin (For Binding Space). 

f) Header & Footer Margin. 



 

 

 

 

 

Paper Size:-   L  W 

a) A4 Size 210*227 mm. 

b) Letter Size 8.5*11 inch. 

c) Legal Size 8.5*14 inch. 

d) A5 Size 148*210mm. 

e) B5 Size 182*257mm. 

f) Photo Size 4*6 inch. 

g) Hagaki Size 100*148mm. 

h) Custom Size (user defined size). 

 

 

 

Page Orientation:- 

a) Portrait (Vertical paper printing). 

b) Landscape (Horizontal paper printing). 



 

 

 

 

 

Print Dialog Box:- 

 

 

 

   

 

   

 

 

   

 

 

 
 

 

 

MS PowerPoint: - (Extension Name .ppt) 

It is graphics s/w which is used for making effective and interesting presentation. 

Various categories of slides are helpful for making presentation.Some of following 

 slides are given below. 

❖ Title Slide. 

❖ Title Only Slide. 

❖ Title & Text Slide.  

❖ Title & Two column text. 

❖ Blank Slide. 

❖ Content Slide. 

❖ Title & Content Slide. 

❖ Title & Two content. 

❖ Title, Content & Two Content. 

❖ Title, Text & Content. 

❖ Title & Chart. 

❖ Title & Organization chart. 

❖ Title, Media clip & Text. 

Etc. 

 

 

 

 

-----------

-----------
----------- 

Portrait 

-----------
-----------

---------- 

 

------------------------------ 

Landscape 
------------------------------
------------------------------ 



Slide:- 

 It is an individual page, where we put our ideas. 

 

 How To Make an Effective Presentation:-  

❖ Collect whole information. 

❖ Organized this information step by step. 

❖ Use appropriate font size & colors. 

❖ Use maximum graphics and images rather than textual information. 

❖ Use judiciously animation effect and transition. 

❖ Use already made template/Design/Model. 

Etc. 

Steps For Making Presentation:- 

❖ Put all information on various slides systematically. 

❖ Apply suitable background. 

❖ Apply suitable Animation. 

❖ Slide Show (Press F5). 

   

   

Viruses:-Artificial Viruses 

 It is computer program, which is used for performing unwanted task. 

 Example:-WORM, Time Bomb, Trojan horse, Laden Mara Gaya, 28 Ferb Happy Birthday 

 Etc. 

Antivirus:- 

 It is used for protecting and killing viruses.   

  Example:-Nortan Antiviruses, Spyware etc 

 

Source of Viruses:- 

 Internet, Pen Drive, Flopy 

 

Full name:- 

HTML   Hyper Text Mark Up Language 

BIOS    Basic Input Output system 

ATM    Automatic Teller Machine 

CU    Control Unit 

CD-RW   Compact Disk Re-Writable 

PROLOG   Programming Logic 

CORBA   Common Object Request Broker Architecture 

BASIC   Beginner All Purpose Symbolic Instruction Code 

FORTRAN   Formula Translation 

POST    Power On Self Test 

CD    Comact Disk 

WORM   Write Once Read Many 

PCB/Motherboard  Printed Circuit Board 

 

Cache Memory:- 

 It is used for increasing processing speed of CPU.It is placed between Primary memory 

and CPU register 

 



 

Question bank Based OS and Computer network:- 

 

Question 1:- What is GUI? Explain its characteristics. 

 

Question 2:- What is Windows? How we handle windows by using keyboard & mouse technique 

 

Question 3:-What is Macintosh Toolbox? Explain it. 

 

Question 4:-What is OS? Describe its evolutions and classifications of OS. 

 

Question 5:-What is buffering and spooling technique? 

 

Question 6:- a:-What is virtual machine? 

  b:-What is role of client/server model? 

 

Question 7:-What is X Windows? 

 

Question 8:-What is computer network? Explain its types and classifications 

 

Question 9:-What is topology and protocols which are used for computer network? 

 

Question 10:-What is serial and parallel transmission? 

 

Question 11:-What are different types of communication modes? 

 

Question 12:- What are different types of communication media/channel? 

 

Question 13:- What are different types of network model? 

 

Question 14:- What are different types of network switching technique? 

 

Question 15:- What is the role of TCP/IP? 

 

Question 16:- What is DNS? Explain with suitable example. 

 

Question 17:- Explain about Linux OS? Also discus its drawback and features 

 

Question 18:-Write functions of Linux commands. 

❖ chmod 

❖ greap 

❖ write 

❖ wall 

❖ cp 

❖ mv 

❖ mkdir 

❖ cal 

❖ man 



❖ touch 

❖ touch > 

❖ ls 

❖ mail 

❖ kill 

❖ vi editor command 

❖ cd 

❖ pwd 

❖ passwd 

Question 19:- Differentiate between Windows 2000 professional and 2000 server? 

 

Question 20:- Explain about architecture of windows 2000 OS? 

 

Question 21:-Describe about windows XP OS? Describe its file system. 

 

Question 22:-What is computer security? Describe goals of computer security. 

 

Question 23:-Describe about security system and facilities. 

 

Question 24:-What is a threat? How we will identify. 

 

Question 25:-What is cryptography? 

 

Question 26:-What are various categories of computer security classifications? 

 

Question 27:-Differentiate among FAT, FAT32 and NTFS partitions? 

 

Question 28:-What are computer viruses? Describe different types of viruses. 

 

Question 29:-What is firewall? Why we use firewall. 

Question 30:-Write short notes of following. 

❖ RAID 

❖ UPS 

❖ PROXY 

❖ IDS 

❖ MAC and DAC 

❖ Authentication 

❖ Domain Controller 

❖ Active Directory 

❖ EFS 

❖ ICS 

❖ NAT 

❖ RADIUS 

Programming Elements of ‘C’ Language:- 
A:-Data Types:-  

1. Simple data Types 

1.1. Integer data types 

Example:- int m=743,b=-89; 

1.2. Real Data type/Floating data Types 



Example:- float x=5.44,y=4443.22; 

1.3. Character data types 

Example:- char p=’a’,n=’8’; 

Example of String char name[15]=”VARANASI”; 

2. Structured data types 

 

2.1 Array:- 

 Collection of similar data types element is called array. 

 

Types of array:- 

 1:-Single dimensional array. 

 2:-Double Dimensional Array 

 

Syntax:- 

Single dimensional array 

   

<Data_types> <Array_Name>[Size]; 

Example:- 

 int m[10]={4,7,1,9,2,2,2,2,2,3}; 

 

m[0]  m[1] m[2] m[3]  m[4] m[5] m[6] m[7] m[8] m[9] 

 

 

 

Example:- float M[2][2]={{3.2,5.3},{13.3,4.5}}; 

    

 M[0][0]=3.2, M[0][1]=5.3, M[1][0]=13.3, M[1][1]=4.5, 

 

2.2 Strings 

 It is sequence of characters enclosed within double quotes. 

 

Example:-1 

“VARANASI” Consist of 9 characters 

‘V’,’A’,’R’,’A’,’N’,’A’,’S’,’I’,’\0’Null Character 

Example:-2 

“V A R A N A S I” Consist of 16 characters 

 

 

 

 

Note:- String terminated by null character ( ’\0’ ). 

Syntax:- 

  

 Data_Types <String_name>[Size]; 

 

Example:-3 

  char name[12]; 

 

Example:-4  

“9”=Two Bytes ‘9’=One Byte 

“a” =Two Bytes ‘a’=One Byte 

 

2.3 Structures 

Structure combine logically related data items into a single unit.The data items enclosed within a structure 

are known as members and they can be same as different data types.It is defined by users as per their 

requirements. 

4 7 1 9 2 2 2 2 2 3 

V  A  R  A  N  A  S  I ‘\0’ 



 

Syntax:- 

struct <structure_Name> 

{ 

 Data_Type1 member1; 

 Data_Type2 member2; 

 Data_Type3 member3; 

 … 

 … 

 … 

 

}<object1>,<object2>…; 

 

struct st1 

{ 

int eno; 

char name[15]; 

char job[15]; 

} obj1; 

Size of structure data type obj1=2+15+15=32 Bytes space into memory 

 

2.4 Unions 

 

 It is the collection of different types of data item.It is different from structure i.e.  in the structure all the 

members uses individual memory locations where in the case of union all the members are pointing the same 

memory locations. The size of memory will be according to the size of that data members whose memory size is 

the biggest among all. 

 

Syntax:- 

union <Union_Name> 

{ 

Data_Type1 member1; 

Data_Type2 member2; 

Data_Type3 member3; 

… 

… 

… 

}<object1>,<object2>…; 

union un1 

{ 

int eno; 

char name[15]; 

char job[17]; 

} obj1; 

Size of Union data type obj1=17 Bytes space into memory 

 

 

3. Enumerated data Types:-It is a user define type,with values ranging over a finite set of identifiers called 

enumeration constants. Example:-1 enum color{red,blue,green}; 

    Color m; The value of m exist red, blue, green. Example:-2 enum flag {true, false}; 

4. Pointer Data type→ It is variable which point the address of variable.Pointer variable represented by using 

indirection operator (*). 

5. void data Type→It is null type of data type 

6. Function 

 Function/Procedure:-  

 It is subprogram which is used for performing some well defined specific task. 



 Function may or may not consist of arguments. Arguments enclosed within parenthesis. 

 

 Example:- 

  f(x)  Function with single argument/Parameter x. 

  f()  Function with no argument/Parameter. 

  f(x1,x2,x3…) Function with multiple arguments/Parameters. 

Advantage of Function:- 

❖ Modular programming. 

❖ Redunction in the amount of work and development time. 

❖ Program and function debugging is easier. 

❖ Reduction in the size of  program due to code reusability 

❖ Library of functions can be implemented by combining well designed, tested and proven functions. 

7. Control Statement: -  

 ‘C’ language provides facilities for controlling the order of execution of the statements, which is referred 

to as flow control statements/control statements. 

There are following three categories of flow control statements. 

❖ Decision Control Statements 

o if statement. 

o if-else statement. 

o nested if-else statement. 

o else –if construct statement. 

o switch case statement. 

❖ Looping Control Statement/Repetitive Control Statement/Iteration Control Statement  

o while loop 

o do-while loop 

o for loop 

❖ Jumping Control Statement 

o goto  

o break 

o continue 

 
if statement:- 

      Syntax 

False if(condition) When true 

  St1; 

  St2; 

  St3; 

  St4; 

  … 

  … 

  … 

  Exit; 

 
Syntax of  If-else-statement:-True 

   False  

if<condition> 

  Statement_blocks_True; 

else 

  Statement_blocks_false; 

  Statement_blocks_Exit; 

 
 

 

Syntax switch-case statement  :- 

It is used for solving choice based problems. It is an alternative of else-if construct statement. 

Syntax:- 



switch(expression) 

{ 

 case <value1>: 

Statement_Blocks_1; 

break; 

case <value2>: 

Statement_Blocks_2; 

break; 

case <value3>: 

Statement_Blocks_3; 

break; 

… 

… 

… 

default: 

Statement_Blocks_False; 

} 

Exit_Statement; 

 

Looping Control Statement/Iteration Statements/Repetition Statement:- 

It allows the execution of some set of statements repeatedly till either for a known number of times or till 

certain conditions are met. 

Syntax of for loop:- 

 

for(initializations;Condition; Updations) 

 Statement_Blocks;   True 

 Exit_Statement; 

 False 

Syntax of While loop:- 

   

   … 

   … 

   … 

while(Criteria)           When condition true 

   { 

   Statement_Body; 

   Updations;                     When condition is false 

} 

Exit_Statement_False_criteria; 

 
Syntax of do-while loop:- 

         Enter 

   do 

{… 

When condition 

 is True  Statement_Body; 

   Updations;                       

          } while(Criteria);       

                 When condition is false  

Exit_Statement_False_criteria; 

 

Introduction To Assembler:- 

   It is a system s/w which is used for converting source code into object code.If 

source code written into assembly language.We know that source code written into object code  

depend upon architecture of CPU. 



 

 Source Code     Assembler  Object Code 

 

Concept of macro Processor In assembly Language:- 

  Many programs contain sequence of instructions which are repeated in identical 

form.The repititions writing of such sequence is controlled by macro processor. 

 

Steps for Executing Source code written in assembly Language:-  

 

Source Code  Assembler     Object Code  Loader Load into Memory Linker 

Link with Library Files    Execution in CPU register. 

 

Note:- Linker and Loader both are system S/W. 

 

Implementation of Assembler:- 

  

  

 

 

• Linker link object code with Library. 

• Loader allocates address for object code into primary memory. 

• Object code also called object module. 

Object module passes Two phase. 

▪ Pass-1 

• It includes following three steps. 

o Separate Symbols, mnemonic codes and operational fields. 

o Determine storage requirements for every assembly statements. 

o Build The symbol.(It is used to store corresponding values). 

▪ Pass-2 

• It generates only object code. If no any bugs found in source codes. 

Loaders and Loaders Scheme:- 

Loaders:-It is system s/w which perform following tasks in assembler. 

▪ Allocation of space. 

▪ Linking of program with library. 

▪ Adjust all address dependent locations. 

▪ Physically load the machine instructions and data into memory. 

Loader Scheme:-It is s/w which is used for performing following activity. 

▪ Absolute loader:- 

o It accept object code & paced into Main memory. 

▪ Relocating Loader 

o It perform the tasks of allocation and linking for programmer. 

▪ Direct Linking loader. 

o It allows the programmer multiple procedure segments & 

multiple data segments & giving him complete freedom in the 

referencing data or instructions.  

▪ Dynamic Loading 

o A binder is used for dynamic loading of functions & other 

machine object into memory. Allocated cells of memory varied 

S C Assembler OC Linker Load  Program Relocating Loader 

Execution of Program 



from one memory cell to another memory cell with the 

pointer.That point address of memory. 

▪ Dynamic Linking 

o There are three types of memory management techniques are 

used in such categories of dynamic linking 

▪ Paging management technique 

▪ Segmentation management technique. 

▪ Virtual management technique. 

Introduction To Compiler:- 

 It is a system s/w which is used for converting source code into object code.If source code 

written into HLL except BASIC.  

 Source Code     Compiler  Object Code. 

 

Approaches to Compiler Development:- 

There are following several approaches to compiler development. 

▪ Assembly language Coding.:-In early edge compiler coded into assembly 

language.Its main purpose is to increase efficiency. 

▪ Cross Compiler:-It is compiler coded into assembly language, which runs on one 

machine and generate code for another machine. 

▪ Bootstrapping-it is a concept for developing a compiler for a language.by using a 

set of same language. Example:- Modula-2 is a compiler that coded into Modula-2 

language.It s shown in following. 

 

Source code Written in Modula-2→Modula-2 Compiler→Object Code 

 

Compiler Designing Phases:- 

 The tasks of compiler can be divided into two sub tasks. 

• The analysis of source code. 

o Lexical Analysis(Scanning) 

o Syntax analysis 

o Semantic analysis 

• The Synthesis of the object code. 

 Lexical Analysis(Scanning):- 

In this phase source code scan from left to right character by character 

& grouped into Tokens having a collective meaning.The output after this phase go 

towards syntax analysis. 

   

Syntax Analysis:- 

In this phase compiler check syntax of source code and generate a parse tree.I 

also perform following other tasks. 

• To remove Tab 

spaces, Blank 

spaces and 

machine 

characters. 

• To produce error 

(Bug) messages. 

Parse Tree(Parser):- 

= 

P 
S / 

m 
n 



 P=m/n 

 

 

 

 

 

 

 

 

Semantic Analysis:- 

  Semantic analyzer derive methods for structuring. It checks data types, Operator  

 checking in source code. 

  The complete diagram of compiler designing phases are shown in following figures. 

 

 

 

 

 

 

 

 

 

 

Symbol table:- 

A  symbol table is a set of locations containing a record for each identifiers with fields for the 

attributes of the identifier.Lexical analysis and sementic analysis both analyzer perform task with 

the help of symbol table. 

 

 

Regular Expression:-  Important for short notes 
  

Introduction Language:-  

A word in the languages or rules can tells us how to construct all the words in the language by some clear 

procedures. 

 

Alphabet:-A finite set of symbols/characters.We generally denote an alphabet by ∑. 

 Example:- 1 

 ∑={m} 
It means alphabet consist of one letter 

 

 Example:-2 

 ∑={0,1} 
It means alphabet consist of digits 0 and 1 

 

Letter: - Each symbol of an alphabet may also be called a letter of the alphabet or simply a letter. 

 

 Example:-3 

 ∑={0,1} 
 

Letter/Symbol=0 and 1 

Example:-4 

SC 
Lexical 

Analysis 

Syntax 

Analysis 

Semantic 

Analysis 

Code  

Generation 

Code  

Optimization 

Symbol Table 



 ∑={m} 
 

Letter/Symbol=m 

 

 

String/Word Over Alphabet: - 

  Evey member of any language is said to be a string or word. 

 ∑={z} 
 

L={z,zz,zzz,zzzz,zzzzz,zzzzzz…} 

  

Where :- 

  z, zz,zzz, zzzz,zzzzz,zzzzzz. . . are called word/Strings. 

Example:-7 

∑={0,1} 
 
L={0,00,01,10,000,001,010,100,0000,0001,0010,0100,1000…} 

Where :- 

0,00,01,10,000,001,010,100,0000,0001,0010,0100,1000… are called word/Strings. 

 

 
Context Free Grammar:-  Most Important 

 

Example:-1 

 

Ram plays. Sentence 

Ram  Noun 

Plays  Verb 

 

<Sentence><Noun><Verb>. 

 

Example:-2 

 

Anil eats a mango. Sentence 

 

<Sentence><Noun><Verb><article><Object>. 

 

 

 

 

What is Grammar:- 

A grammar G is defined as:- 

 

G=(V, ∑,P,S) 

 

Where V is called the set of variables 

 

∑ Is the set of terminals/Input symbol. ie(a,b) 

 

P Is a set of product rules 

  

S Is a special variables called the start symbol S belong in V 

 

Structure of  Grammar:- 

Let L is a language over an alphabet A,then a grammar for L consists of grammar rules of the 

form. 



 

xy x is replaced by y.It is called derivation 

Every grammar has a start symbol, which must be at least one production with the left side 

consisting of only start symbol. If S is start symbol then its production rule is 

    Sy 

Example:- 

Let A= {a, b, c} then a grammar for the language A*(Clean Star/Clean Closure) can be described 

by following production  

rules:- 

 

 

 

S^ 

SaS 

SbS 

ScS 

 

 

SaSaaSbaaScbaaS 

 

Sential Form of  Grammar:- 

 

   A string made up of terminals and /or non-terminals is called sential form 

Example:- 

 G =(V, ∑,P,S) 

 

V={<Senetence>,<Noun>,<Verb>} 

 

∑={ Anil, eats, a, mango} 

 

P=<Sentence><Noun><Verb><article><Object>. 

 

<Noun> Anil 

 

<Verb> eats 

 

<Article> a 

 

<Object> Mango 

 

S=<sentence> 

 

Software Tools for Compiler designing:- 

 There are following two tools are used in compiler designing. 

• Lex Tool(A lexical analyzer generator) 

• Yacc Tool(A parser generator) 

Lex Tool:- 

It is s/w tool that makes as input specifications of a set of regular expression together with 

actions to taken on recognizing each of these expressions.
Lex 

compiler 

C Compiler 

Lex Source code 

Lex.yy.c 

m.out 



YACC Tool(Yet Another Compiler Compiler):- 

 It is a s/w which is used for creating parser which will be output in a form suitable for 

inclusion in next phase. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Threads:- 

  A thread is a lightweight process with a reduced state & state reduction is achieved 

 by having a group of related threads share other resources such as the memory and files. In 

 thread based system, threads take over the role of processes as the smallest individual units 

 of scheduling. In such system, process or tasks serves as the environment for execution of 

 threads. 

 The process thus becomes a unit of resource ownership, such as memory and files, for 

 collection of threads. 

 Threads are a convenient mechanism for exploiting concurrency within an application. 

 Threads have been successfully used in implementing network servers. 

 Threads are a relatively recent development in OS.They may be found in Mach and OS/2 

 operating systems.Several implementinations of thread packages as preprocessors for  

 programming languages, such as ‘C’  & ’C++’ language. 

 There are two categories of process with respect to threads. 

• Single threaded process. 

• Multithreaded process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Yacc 

Compiler 

C Compiler 

m.out 

Yacc specification 

Y.tab.c 

m.out 

Input stream 

Y.tab.c 

Output 

Code data files 

Registers stack 

Thread 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Note:-Thread invoke process. 

 

 Optimal Page replacement algorithm:- 

  FIFO→First In First Out 

  LRU→Least Recently Used 

  OPT→Optimal 

 

 FIFO→First In First Out 

  Example:- 

   A succession of memory references made by a program executing on a  

   computer with 1 MB of memory is given below in hexadecimal notation: 

    

 

     Reference String 

 

 

 PFO            

              Page Frames 

 

 

 

 

  

Code Data Files 

Registers Registers Registers 

Stack Stack Stack 

144 A1 144 263 144 A1 179 A1 A2 263 

144 A1 ---- 263 ---- ----- 179 ----- A2 -----

- 
----          



 



 


